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If there are no serious objections, these changes will be
scheduled for Implementation.
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The following is my understanding of the agreements made in the
recent NLS command language meetings plus a few additional
suggestions., Unless someone feels th need to discuss this

further,

the changes described here will be scheduled for

implementation and will be accompanied by documentation changes.

The following changes will be made in the command language:

The command language will be made to consist of

first level commands

frequently used commandsy, which are recognized by
their first letter

second level commands

infrequently usedy new,; or experimental commands,
which are "one shot" and which are either recognized
when the user types enough characters (this will be
the system default) or, as a user setable option,
only upon user request., (Recognition is requested by
typing a CAy, ALTMODE, or SP (as in TENEX) — This
user setable option would be saved In the user's
PROFTLE (explained below)). Recognition within these
second level commands should be via this same method,

This allows new commands to be added without
worrying about first letter conflicts —— a
significant problem currently.

These commands can be repeated by making further
bug selections. However, If a non—bug selection
character Is input it will be parsed at the top

level,

That isy the command can have subcommandsy; but
one can not change from one subcommand to
another without specifying the full command
again.

subsystems.

The subsystem name is recognized upon reguest or
sufficient type in (as in second level commands).
Once in the subsystem the same pattern should be
applied ( top level, second level, and subsystems).
All subsystems should terminate with the "Quit"

La
lal

lala

lalal

lalb

lalbl

lalbla

lalblb

lalblbl

lalc
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command, as should NLS. All subsystems should have
help commands. lalcl

The concept of Address Expression will be generalized for
DNLSs TNLS, and DEX such that wherever a statement name or
number is currently used, an appropriate ADDRESS EXPRESSION

will be allowed. 1a2
For DNLS,; a selection will be defined as laZa
SEL = (BUG / CDOT DAE CA) $( ALTMODE DAE CA); la2al

note that this syntax allows one to make a

selection and then modify it any number of times

with a DAE (Dynamic Address Expression) which will

use the current result as Its starting point, laZ2ala

If a CDOT DAE CA is used instead of a BUG, the
starting point for that DAE will be lalalal

for the first selection of the command, lal2alala

the first character of the statement
which should appear at the top of the
display area, laZalalal

or for subsequent selections, laZalalb
the result of the previous selection. laZ2alalbl

If the command requires the identification
of a display area, this will be based on the
position of the cursor when the CA is typed.
laZ2alalc
Note also that the statement name/number field of
a link will contain a DAE (see definition of a
link below). laZ2alb

The Jump command will be defined to expect either
a SEL or a SP DAE CA $( ALTMODE DAE CA). la2alc

Note that the use of markers in DNLS by holding

the rightmost mouse button down and typing the

marker name will no longer be possible. Instead,

one will be able to type CDOT (will be avallable

on the mouse) and an arbitrary DAE followed by a

CA. la2ald

In TNLS a selection will be defined as lLa2b



1yl CHI 14—-APR-72 16:38 10081
Suggested Changes to NLS

SEL = DAE CA $S( ALTMODE DAE CA); la2bl

This allows one to modify a selection if it was
incorrect. La2bla

The starting point for the first selection of a

command will be the CM (CSP)., The starting point

of subsequent selections will be the result of the
previous selection. la2blb

The CM (CSP) will not be modified until the

successful completion of the command —— as is now
the case. laZ2ble
In DEX a selection is defined as la2c
SEL = STAE CAj la2cl

Where DAE ( Dynamic Address Expression) is defined below,
and STAE (STatic file Address Expression) is defined in
the DEX-II design document. laZd

A Dynamic Address Expression should be consistent
with existing linksy, the same DAE should work in TNLS
and in DNLSy; and the elements of the expression
should be reasonably mneumonic. A DAE should be
available in NLS wherever a statement number or
statement name is now used (as Iin links, Jjumps,

etc. )s This DAE will be as follows: la2d1
Dynamic Address Expression elements la2dla
location number la2dlal

A statement number is D (L / D). la2dlala

note: no alphabetic zero. la2dlalal

name la2dla2

A statement name is as defined by the name
delimiter routine —— currently defined to be
L S(L/ DJ YY) V=), la2dla2a

Note that "' and "—- are included in this
definition of name so that attempts to
terminate a name In a DAE with an element
begining with "! or '—- will not work
properly. To get this segquence to work,



]

Suggested Changes to NLS

one will have to terminate the name with
la2dla2al

a SP or period.

(I suggest that at some point in time

CHI
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the definition of statement name could

stand some improvement -——

L $(L/ D) and use upper—lLower case

Letters (e.ge.

SriArc) and format

routines to put in arbitrary special
characters when printing or
interacting with the user, as in the

ident system,

visibles. )

or make names be

Like make it

la2dla2lala

A sequence of digits and letters preceeded
immediately by a period can contain the

following letters,

meaning. NOTE:
59

[ number]'s
times

[ number ]'p
times

[ number]'u
[ number ]%d
[ number ]'a
[ number ]*' r

[ number ]"fa®
times

[ number ]"fe"
times

[ number ]'o
[ number J'e
[ number ]'n
[ number ]'b

[ number ]'h

with associated "Jump"

default value for <{number)> is

Jump

Jump

Jump
Jump
Jump
Jjump

Jump

Jump

Jump
Jump
Jjump
Jump

Jump

to

to

to

to

to

to

to

to

to

to

successor <{number)

predecessor <{number)

up <number?> times
down <number)> times

ahead <{number)> times

return <number)> times

file ahead <number)>
file return <number)>
origin

end

next <number)> times

back <number> times

head

La2dlald
la2dlada

la2dladb
la2dladc
la2dladd

la2dlade

la2dladf

la2dladg

la2dla3hn
la2dladi
la2dladj
la2dladk
la2dladl

la2dladm
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[ number ]J' t Jump to tail la2dladn
[ number]'1L jump to the <numberd>th link 1a2dlado
[numbar]‘w Jump to next occurance of word
<number> times la2dladp
[ number ]'c Jump to next occurance of

content <{number) times la2dladqg

a sequence of digits and letters preceeded
immediately by a plus (skip forward) or minus
(skip backward) can contain the following
letters, with associated meaning. NOTE,

default value of <number> is 1. la2diad
[ number ]'c skip <number> characters la2dlada

[ number ]'w skip <number> word la2dla4b

[ number ]'v skip <number> visible la2dladc

[ number ]'i skip <number)> invisible la2dlad4d

[ number ]'n skip <number> number(s) la2dlade
scans for a digit. laZ2dla4del

[ number ]'L. skip <number> link(s) la2dia4f

[ number]'l skip <number)> line(s) la2dladg

determined by current level and window

slze la2dladgl

"% name Jumps to the next statement by that
name la2dlaS
'( text ') link la2dlab
text.= Comment FileAddress ViewSpecs; la2dlaba
See definition of link below, la2dlabal
' [ text '] content search la2dla?

text excludes ' ] unless preceeded by the
literal escape character la2dlaTa
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1< text *> word search
text excludes "> unless preceeded by the
Literal escape character

'3 text ' intra—-statement content search
text excludes "; unless preceeded by the
Literal escape character

"' character character search

- beginning of statement

> end of statement

"# text marker name, text = L $(L/D)

"] text Statement IDentifier (SID), text = 18§
an SID is a system supplied identifier for
each statement in a file. Each SID is
unique within a file, The SID of a deleted
statement will not be reused. SID may be
displayed and printed just as statement
numbers are. 1

vy print context

. print statement

"2 reference pointer

note that "/ and * are part of a DAE. In DNLS this

will be accomplished wvia a two line tty-simulation
area above the Command Feedback Area which will also
allow one to see broadcast messages and
terminal—linking dialoge.

The syntax of a link will be as follows:

Link

LeftDelim Comment FileAddress ViewSpecs
RightDelim;

LeftDelim

(% £ <) SNP;

1

la2dla8

la2dlaBa

la2dla9

la2dla9a

la2dlal0

la2dlall

la2dlal2

la2dlall

L
la2dlald

a2dlal4a

la2dlals

la2dlalé

la2dlal?

la2d2
ia2e

la2el

laZ2ela
laZelb

laZelbl
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Comment = la2elc
[ Commen tText CommentSep ] laZelcl
Commen tText = laZelc2

any text excluding LeftDelim, RightDelim,

and CommentSep. la2elc2a
CommentSep = la2elcd
n__ng laZelcda
FileAddress = laZeld

$NP [ DirName FieldSep FileName FieldSep DAE / laZeldl

DirName FieldSep Fi leName / laZeld2
FileName ] $NP; la2eldd
DirName = la2eld4d
valid directory name; laZ2eld4a
FileName = la2eldS
valid file name; la2eldSa
DAE = ' laZeldb
Dynamic Address Expression; la2eldba
FlieldSep = la2eld?

If there are no commas in the FlleAddress

then lal2eld7a

1$NP la2eld7al
otherwise la2eld7b

SNP ', SNP; la2eld7bl
ViewSpecs = la2ele
[ViewSpecSep ViewSpecText |3 la2elel
ViewSpecSep = la2ele2
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the following interpretations will be applied to links:

¥: S$NP;
ViewSpecText =
$(L / NP);
RightDelim =

SNP (') / *>);

(text text text :text) or (text, texty, text :text)

12 (dirnamey, flename, DAE * viewspecs)

2: Scan from current RightDelim to end of
statement for next RightDelim; try again if find
one.

(text text :text) or (text, text :text)

12 (dirnamey; flename : viewspecs)
2: (flenamey DAE : viewspecs)
d: Scan from current RightDelim to end of

statement for next RightDelim; try again if find
one.

{ text text)

12 (flename 2 viewspecs)

2: (DAE : viewspecs)

J: Scan from current RightDelim to end of
statement for next RightDelim; try again if find
ones

text, text :text)

1: ( flenamey, DAE : viewspecs)

2: Scan from current RightDelim to end of

statement for next RightDelim; try again if find
ONes

( texty; text, =text)

CHI 14—-APR-72 16:38 10081

laZele2a
laZeled
lal2elelda
lalelf
LaZelfl
la2f
;aZtl

la2fla

la2flb
1la2f2
la2f2a

1a2¥2b

la2f2c
La2f)
1a2f3a

la2f3b

1a2£3c
1a2f4

la2f4a

la2f4b

1a2£5
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1: (dirname, flename, : Viewspecs) la2fSa

2: Scan from current RightDelim to end of
statement for next RightDelim; try again if find

one, la2f5b
{(y9 text ztext) la2té
1: (49 DAE : viewspecs) la2tba

2: Scan from current RightDelim to end of
statement for next RightDelim; try again if find

one. la2f6b
(stext) - 1a21£7
12 (: viewspecs) 13217;
(text,, text :text) la2f8

l: Scan from current RightDelim to end of
statement for next RightDelim; try again if find
one. la2f8a

The replacement of the statement name/number field by a
DAE provides a powerful extention to the link syntax and
will be compatible with extant Llinks. la2g

Also, LSNP may be used instead of comma as a field
delimiter in links provided the FileAddress does not

contain any commas. la2h
Editing command changes 1Lad
For editing commands, it will be possible to lada

1) specify more than one operand type fadal

This excludes insert and delete, of course. ladala

2) modify the verbs of editing commands through the
use of the prepositions "ahead" or "onto'", and the
adjective "Filtered". lada2

The preposition "Filtered" can be specified for
all structure manipula tion commands (excluding

inserts, of course). ladaZa

This will cause the command to use the segquence
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generator in performing the operation (i.e. the
operation will be perform only on those

statements which pass the filter, consisting of

the viewspecs and user content analysis and/or
sequence generator programs). lajda2al

For a filtered delete ( FDelete), whenever a
statement is deleted 1ts sub structure will
be moved up one level in the structure. lalda2ala

In addition, either of the prepositions "Ahead" or
"Onto" can be specified for the insert, move, and
copy commands. la3a2b

"onto" is essentially a replace ( followed by a
delete for move), lada2bl

"ahead" means to insert the new text ahead of
the selected location instead of following it. lada2b2

Jd) use CDOT to terminate all editing commands, This

will mean terminate the current command and begin an

insert statement command, having selected the

statement to which the CM (CSP) would have moved in

TNLS. 1aldad

4) specify a set of operands to a single command. lada4

For example, one will be able to specify the move
branch command, select the target and a set of :
branches to be moved (using TAB), followed by the .
final CA. lada4da

This requires a new flavor of confirmation,
TABy which does not terminate the command but
rather accumulates operand selections. 1aldadal

Also, the notion of operand—type defaulting in DNLS will
be changed so that it is like Jump to Item. That is,
for any given command, the default is always the same

(statement —— or should it be branch? —— for all editing
commands )y, and an extra CA to accept the default will
not be requlred. 1adb
The general form of NLS editing commands will be ladc
textual editing: ladcl
For DNLS ladcla

10
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DTECommand =
operation <operand-type-default)
[('a <Ahead> / "o <Onto>)
{operand-type—default) ]
[1st-textual-operand—type
[ 2nd-textual-operand-type ] ]
operand—-selections
{niz]
Confirmation;
For TNLS
TTECommand =
operation
[*a <Ahead> / "o <Onto) ]

Ist—textual—-operand—-type

[ ALTMODE 2nd-textual—operand-type ]

operand—selections
[LiT]

Confirmation;

16238

10081

ladclal
ladclala
la3clalal
la3clalala
ladclala2
ladclala2a
ladclalb
ladelalbl
ladeclalc
ladclb
Lal3clbl
iadclbla
ladclblal
la3clblb
la3ciblbl
1&301;10
ladelblel

ladclbld

Where the optional LIT following the operand
selectiions is not allowed for delete, replace (1f

two operands were selected),

and transpose.

ladclc

Note this allows one to type in an optional

literal when moving or copying textual
The literal will be Inserted between
as in append statement.

operands.
the old and new text,

If a space would normally have been
the literal will be inserted

inserted,
instead,

11

ladelcl

laldclcla
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structural editing: ladec2
For DNLS 1adca
DSECommand = ladc2al
operation {default—operand—-type> ladcZ2ala

["f <Filtered> <{defaul t-operand—type> ] la3dc2alal

[('a <Ahead> / "o <Onto>) ladc2ala2
<default-operand—type ] ladc2alaZa

[ 1st-structural—-operand-type ladc2alal

[ 2nd-struc tural-operand-type ] ] ladc2alada
operand—selections ladc2alb
LEVADJ [LIT] la3c2alc
Confirmation; la3c2ald
For TNLS 1adc2b
TSECommand = lade2bl
operation 1adc2bla
[*f£ <Filtered) ] lnéthlnl

[*a <Ahead>/'o <Onto)> ] 1a3c2bla2
lst—struc tural-operand—-type 1ladc2blb

[ ALTMODE 2nd-struc tural—operand-type ] 1laldc2bibl

operand—-selections lade2ble
LEVADJ [LIT] ladc2bld
Confirmation; ladc2ble

Where "filtered" is not available for Insert and

LEVADJ is only valid for move, insert, and copy,

and the literal following the LEVADJ is only valid

for insert, i ladc2c

12
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where 1a3c3
Confirmation = Ladcda
$(TAB operand—selection) (CA / CDOT); 1adc3al
"ahead" and "onto" are valid only for Move, Copy,
and Insert, ladecdb
The 2nd-operand—type option is not available for
the Insert and Delete commands,; and no
operand—type specification is allowed for Append
and Breaks. 1adc3c
Substitute changes 1a3d
An elipses capability will be made available in the
substitute command. That is, text...text will be
allowed for the specification of text to be replaced.
This will result in instances of <{textl arbitrary
text text2> being replaced in the substitute. Laddl
This is subject to the constraint that the
{textl,..text2> be in one statement, and that an
occurance of textl can only be paired with the
first occurance of text2 following textl. taddla

14—-APR-72 16:38 10081

If textl is null then assume String Front (SF);
if text2 is null then assume String End (SE). Laddlal

Also, the "filtered" option wi

LL be available for

‘substitute. 1ladd2
In TNLS, the substitute command will be changed so
that it will accept either a literal or a SEL. 1add3
The form for the substitute command Ulli be ladd4
DSubstCommand = ladd4a
's {Substitute)>
{struc tural—operand—type—default> ladd4dal
[filtered] ladd4ala
[ 1st—textual-operand-type
{structural—-operand—type—default> 1lald4alb

13
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[ 2nd—textual—-operand—type

<{structural-operand=-type~default> ]] 1alddd4albl
[ structural-operand—type ] ladd4alc
structural-operand-selection ladd4a2

18((LIT CA / CDOT textual—-operand-selection) 1add4ad

(LIT CA / CDOT textual—-operand—-selection)) ladd4a3a

Conflrmation; ladd4ad
TSubstCommand = ladd4b
's <Substitute> 1add4nl
[filtered] ladd4bla

[ 1st—textual-operand- type 1add4blb

[ 2nd-textual-operand-type ]] 1a3d4blbl
structural—-operand-type ladd4b2
structural-operand—-selec tion ladd4bd

1$((LIT CA / CDOT textual—-operand-selection) 1ald4db4
(LIT CA / CDOT textual-operand—-selection)) la3d4b4a
Confirmation; ladd4bs

In TNLS,; the replace command will expect a lLiteral as

its second parameter unless the user types CDOT. lade
The form for replace in TNLS will be ladel
TReplaceCommand = Lladela

"r {Replace> laldelal
[filtered] ladelala
lst—operand- type ladela2

[ 2nd—operand-type ] ialdelala
lst—operand—-se lection ladelad

14



CHI 14-APR-T72 16:38 10081
Suggested Changes to NLS

(LIT / CDOT 2nd—-operand—selection) ladela4d
Confirmation; Ladelas
The delete statement command will be made valid even if

the statement being deleted has sub—structure. In this
case the substructure will be moved up one level in the

structure. 1adf
Level adjust will be defined as ladg
LEVADJ = $('u/'d) [SP /7 cA]; ladgl
instead of $([NUM] ("u/'d)) [sSP / CAl. ladgla

A new Force Case (XSET) mode; Initialcaps,; will be added
to force the first letter of each word to upper case and _
the rest to lower case, ~ ladh

Textual Operand Types (TOT) are . 1a3di

TOTNoSpace = character / invisible / text /
- : , statement; 1a3il

TOTInc ludeSpace = word / visible / number / Llink; 1adi2

fbeOneSel = character / word / visible / lnvlsible.}

number / link / statement; II 18313
TOTTwoSel = text; 1adi4
Structural Operand Types (SOT) are .laSJ
SOT = statement / branch / plex / and group; I  ladjt
S0TOneSel = statement / branch / plex; 1a3j2
SorrwoSel = group; ' ladjd

Help commands will be available for all of NLS. iLa4

A novice command will be added to NLS such that in DNLS
a 'new display area will show the user what the system
next expects frowm him. This will be done for TNLS also

but will be echoed as part of the command feedbacka. ! lada
' such as ' ' ladal
BC / SEL / LIT / CD ladala

15
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or
Final CA / CDOT / TAB / CD
or
Next Command / SEL
or
lst operand type / SEL / CD
or

2nd operand type / SEL / CD

It might be nice in TNLS to automatically type out the
statment where the CM (CSP) was positioned at the
termipatlon of all commands.

In additiony, it might be nice to get feedback when
making selections.

Thus, I suggest a command which will cause a '/ to be

‘appended to all DAE's which do not already end with a

"/ and which will cause the statement where the CM

was left to be printedy; moving the CM to the heginnlk
. ' of that statement.

Optionally, one could have a '/ done at the end of
the edit instead of a " . Also, the number of
charaters which "/ types should be increased.

I propose that this command be called Execute
assistancey, with subcommands like feedback and

print statement at end of edita.

This should be automatically invoked as a result

of the Novice commanda. Also,; one should be able
to set the number of charcters to type in the '/
commanda.

Terminal Specific

For the TI terminal, I suggest the following character
definitions be made standard:

CA: CR

16

lad4a2
ladala
la4ad
la4ada
lLlad4a4d
ladada
1a4abS

lad4aS5a

lad4b

la4bl

ladb2
lad4bla

1la4b2b

ladb2c

1a5

laSa

laSal
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Cea: (verticle bar) laSa2

Cp: ~ (key to left of DEL) laSad

BC: tilda la5a4

New mouse button functions Lab
CDOT on mouse —— two right most buttons down and up. laba
ALTMODE on mouse — all buttons down and up. laéb

TAB on mouse —— left— and right-most buttons down and
Uupe labe

In addition to its normal meaningy, TAB will also be

used as a new form of command conflrmation which

indicates that the user wishes to continue making

selections before actually executing the command. label

This capability is described below. labecla

Alsoy in TNLS; TAB at the top command lLevel will mean
that the user wishes to continue making selections

for the last command which he specified. Llabe2
control shift on mouse —= all buttons down. labd
Jump command changes 1a7

The Jump commands will be made to be like the rest — no
state of its own, laT7a

Jump to Successory Jump to Predecessor will require
one to type 'J 'S 'J 'P jjust as Insert Character,
Insert Word requires one to type "I 'C "I 'w, la7al

Jump to Return ( Ahead) will be like Jump File Return

( Ahead) in that it will display the first 15 chars of

the statement In the name area and allow the user to

skip back ( forward) through the ringe. 1a7b
The sub commands of Jump to End will be deleted. la7c

The Jump File Return command will be removed since Jump
to Link will be exactly equivalent. 1a7d

The Goto Display Area Control facility will be replaced by
a Window command which will have "Half" commands which will

17
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split a window Into two halves (horizontally or vertically)
as well as other facilities.

There will be a "Print—-rest—of-file" command in TNLS.
Viewspec changes

The meaning of A;B viewspecs (indenting onjoff) will be
changed slightly as follows: indenting off will mean
left justification if branch only or plex only viewspecs
are in effect and will have no effect otherwise.

New viewspecs will be defined for SID's. One pair will
determine whether or not they are displayed/printed and
another pair will de termine whether they appear on the

left or on the right.

In general; we could conserve viewspec letters Iif we
used double letters. For example, we could use "n" to
mean numbers on and "nn" to mean numbers off. We could
even go to triples for the i, jsk and z,h,l viewspecs.

The character RUBOUT will be a no—op charcter. Control 0O
will serve the same purpose.

This is because

1) RUBOUT is often typed by accident, thus aborting
the command and

2) RUBOUT is a very common noise character for phone
lines.

The character Carriage Return (CR) will be useable as CA or
CDOT.

This almost works now, but echos an extra CR LFa.

The user now has to use the character definition
capability to set this up (set echo to null). When the
PROFILE mechanism is working, the users character set
definitions will be automatically retrieved when he
enters NLS,

A new file will be maintained for each user,; called the
user PROFILE. This file will be used for maintaining user
specific data and state information.

The user's command language defaults and macros,

138

1a8

La®

1al0

Lal0a

lalOb

lallc

lall

lalla

lallal

lalla2

1al2

lalla

lal2b

lald
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character definitions, display area positioning and
configuration, jump and link rings, as well as his
editing history list will be maintained in his PROFILE. lalda

This allows the user to maintain his jump and link
rings over more than one session and allows him to
see a description of the edits that he has made as
well as the ability to undo those edits. lal3al

WHP is writing up a description of the PROFILE and
how this will work., We will have some meetings to
discuss what the PROFILE will be used for initially. lallda2

The IDENTFILE was suggested ealier for some of these
functions. It seems very unwise to use a critical
file like that for these purposes. Also, the data

might get quite large for some users, laldald
Proposed Command Language 1b
Definitions ibl

TﬂxtspBCI = "¢ eee Character> / "w Ceoe VWord> / "'v €aeoe
Vlsible) , LE & Laoa Invisihle) / Ll R Ceeese Line> , "L <---
Link> / "n <..e Number)>; lbla
TextSpec2 = "t €eee Textd; iblb

StructureSpecl = '"s ... Statement)> / "b <.e.e. Branchd> /

'p €eee PlexD>; iblc
StructureSpec2 = "g <... Group)>; ibld
Where ... x> denotes Ible

for DNLS iblel

x replaces the current last word in the Command

Feedback Line iblela
for TNLS lble2
x is appended to the command echo. 1ble2a

In the followingy x and ¥y are instances of either TOT's,

SOT"sy or literals, The specification of what types of
operands they are is assumed to be inherent in the

command specification. iblf
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First level commands b2
? 1b2a

prints the names of all the commands available at the

first levely with a comment about typing the first

letter of any command followed by a '? to find out

about that command. Also the user is advised to use

the command Help to find out about definitions. Ib2al

append statement Ib2b

Syntax: "a <Append Statement> SEL SEL [LIT]

Confirmation; 1b2bl
break statement 1b2c
Syntax for DNLS: "b <{Break Statement at Visible)> ib2el

[ TextSpecl] SEL [CDOT LEVADJ] [LIT] Confirmation; 1b2cla
Syntax for TNLS: 'b <{Break Statement at)> ib2ec2
[TextSpecl] SEL [CDOT LEVADJ] [LIT] Confirmation; 1b2c2a

copy Ib2d
Syntax for DNLS: "¢ {Copy Statement) 1b2d1

([ Yo <Copy onto Statement> / 'a <Copy ahead

Statement) ] 1b2dla
(TextSpecl 1b2dlal
(TextSpec2 SEL / [TextSpecl]) ib2dlala

SEL SEL [LIT] / lb2dlalb
TextSpec2 ib2dla2
(TextSpecl / [TextSpec2 ] SEL) ib2dlaZa

SEL SEL [LIT]) / 1b2dla2b

[*f <oee Filtered Statement) ] 1b2dla3

( StructureSpec?2 lb2dlada

( StructureSpecl / [StructureSpec2] SEL)
1b2dladal
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SEL SEL LEVADJ / 1b2dlada2
Struc tureSpecl 1b2dladb

{StructureSpec2 SEL / [StructuresSpecl ])

1b2dladbl

SEL SEL LEVADJ) / 1b2dladb2

SEL SEL LEVADJ) 1b2d1lb

Confirmation; 1b2dle

Syntax for TNLS: 'c <Copy> 1b2d2

([ "o <Copy onto> / 'a <Copy ahead ] 1b2d2a

(TextSpecl 1b2d2gl

(TextSpec2 SEL / [TextSpecl ]) 1b2d2ala

SEL SEL [LIiT] / 1b2d2alb

TextSpec?2 1b2d2a2

(TextSpecl / [TextSpec2] SEL) 1b2d2a2a

SEL SEL [LIT]) / 1b2d2a2b

["f <ewe Filtered) ] ib2d2a3

(StructureSpec2 . 1b2d2ada
(StructureSpecl / [StructureSpec2 ] SEL)

1b2d2adal

SEL SEL LEVADJ / 1b2d2alda2

Struc tureSpecl 1b2d2aidb
(StructureSpec2 SEL / [StructureSpecl])

1b2d2adbl

SEL SEL LEVADJ)) I1b2d2a3b2

Confirmation; 1b2d2b

Semantics: - 1b2d3

TextualCopy [onto/ahead] x y [LIT] 1b2d3da

If onto then 1b2d3al
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equivalent to TextualReplace x y
Otherwise

equivalent to insert [ahead] x y with
insertion semantics of y.

If LIT NOT= Null then
If ¥ = TOTIncludeSpace then
LIT is used instead of SP in
IncludeSpacelnsert
otherwise
If ahead then
NoSpacelnsert of y LIT

otherwise

NoSpacelnsert of LIT y.

StructuralCopy [onto/ahead ] [filtered] x y LEVADJ

If onto then

10081

1b2d3ala

1b2dJda2

1b2d3ala
1b2d3a2al

1b2d3dalala

1b2d3dalalal
1b2d3a2alb
indSﬁZalbl
i1b2dJda2albla
ib2d3a2alb2
1b2d3a2albla
ib2d3b

1b2d3bl

equivalent to StructuralReplace [filtered] x

¥y

Otherwise

1b2dJbla

1b2d3b2

equivalent to Structurallnsert [ahead] x y°

LEVADJ, where y'
passed the filter.

Example:

copy character
visible>» ca

the text of

a spacey, is

character,.
delete

Syntax for DNLS: 'd <Delete Statement)

22

is that portion of y which

1b2d3b2a

ib2d4

visible <{select character> <{select

ib2d4a

the selected visible, preceeded by
inserted following the selected

1b2d4al

ib2e

ib2el
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(TextSpecl / TextSpec2 SEL) SEL / ib2ela
(["f <Delete Filtered Statement) ] 1b2elb
([StructureSpecl ] / StructureSpec2 SEL) i1b2elbl
SEL ) lb2elb2
Confirmation; Ib2elc
Syntax for TNLS: 'd <Delete> 1b2e2
(TextSpecl / TextSpec2 SEL) SEL / ib2e2a
(["f <Delete Filtered)] ib2e2b
(StructureSpecl / StructureSpec2 SEL) 1b2e2bl
SEL) lb2e2n2
Confirmation; 1b2e2c
Semantics: 1b2ed
TextualDelete x Ib2eda
If x = TOTIncludeSpace then 1b2e3al
IncludeSpaceDelete x Ib2edala

If there is a space on the right, Ib2e3alal

delete x SP 1b2e3alala

otherwise ib2eldala2

If there is a space on the Lleft, Ib2e3alaa

delete SP x. lb2e3ala2al

otherwise 1b2edalalb
NoSpaceDelete x. 1b2edala2bl

Otherwise Lb2eda2
NoSpaceDelete x lb2edala

Just the text of x is deleted. 1b2edalal
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StructuralDelete [filtered] x ib2edb
The structure x is deleted from the file. Ib2edbl

if filtered, then only those statements
passing the filter will be deleted. 1b2edbla

Whenever a statement is deleted lits
sub-structure is moved up one level in

the structure. 1b2edblal

execute (second level command) ib2f
format 1b2g
syntax: 'f <format ford> ib2gl
('"q <Quickprint> / 1b2gla

's {Sequential File> / 1b2glb

"d <{Device Printer> (etc.)) lb2glc
FILENAME Confirmation; 1b2gld

goto subsystem 1b2h
help 1b2i

prints out instructions for new or confused users
including definitions of terms used in syntax rules

for commands, ilb2i1l
insert lbiJ
Syntax for DNLS: '"ji <{lInsert Statement) ib2j1
((TextSpecl / TextSpec2) SEL / 1b2jla
(StructureSpec2 / [StructureSpecl ]) SEL [CDOT
LEVADJ ]) 1b2jlb
LET 1b2jlec
Confirmation; ib2jld
Syntax for TNLS: '"i <Insert> 1n2j2
((TextSpecl / TextSpec2) SEL / 1b2j2a
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(StructureSpec2 / [StructureSpecl ]) SEL [CDOT

LEVADJ ]) 1b2i2b
LIT 1b2j2¢c
Confirmation; 1b2j2d
Semantics: 16233
Textuallnsert [ahead/onto] x ¥y 1b2j3a
If onto then 1b2jdal
equivalent to TextualReplace x y Ib2j3ala
otherwise ib2jla2
insert semantics of x 1b2jJdala

if x = TOTIncludeSpace then ib2jla2al
IncludeSpacelnsert of ¥y Ib2jla2ala

If ¥ is being inserted ahead of x

then ib2 j3a2alal
insert y SP before the first
character of x. Ib2jda2alala
otherwise, Ib2 jJdaZ2ala2

insert SP y after the last

character of x. Ib2jla2alala
otherwise 1b2j3ala2
NoSpacelnsert of y. l1b2j3a2ala

If ¥y is being inserted ahead of x

then 1b2jJdaZ2alal
insert y before the first
character of x 1b2jJda2alala
otherwise 1b2 j3al2alal

insert y after the last
character of x. 1b2jlda2alala
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Structuralinsert [ahead/onto ] x y LEVADJ 1b2j3b
It onto then 1b2j3bl
equivalent to StructuralReplace x ¥y i1b2jibla
otherwise 1b2j3b2
insert y as a new statement 1b2jib2a

If "ahead" then the level adjust
semantics will behave as though the user
had selected the predecessor of the
selected statement, even 1If there is no

such predecessor statement. 1b2 jib2al
Example: 1b2,j4
insert ahaed word <{select word> <enter lit)> ca ib2 jda

the literal followed by a space is inserted

before the first character of the word. 1b2 jd4al
Jump (DNLS and TNLS) 1b2k
Syntax for DNLS: '"j <{Jump to I[tem> 1b2k1l
('L <eae Item> / 1b2kla
s <ees Successor> / . 1b2klb
'p €ees Predecessord> / 1b2kle
'u Caue Up> / ' 1b2kld
'd <ees Downd> / 1b2kle
'h €eee Head> / b2kl ¥
Tt Cooe Taild> / i1b2klg
e {eee End of Branch> / 1b2k1lh
"0 €aee Origin> / Ib2kli
'l <ses Link> ) (SEL / SP DAE CA S(ALTNODE DAE
CA)) VEIWSPECS / b2kl j
'r €ees Return> 1b2klk
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%text from next statement®% S(NOT Confirmation
%text from statement®%) /
<.-- Aheﬁd)

%Stext from next statement® S(NOT Confirmation
%htext from statement®) /

€eee File Returnd>
[.ﬁ <... Ahﬁﬂd) J

*r <Caeee Returnd]

%file name% $( NOT Confirmation %next file
name%) /

Cees Name

[*f <eo. Name First)> /

'n oo+ Name Next)]

(SEL / LIT CA) VIEWSPECS /
€ess Content First)>
[*% <ewe Firstd> /
'n €eee Next>]

(SEL SEL / ALTMODE <Accept old content> / LIT
CA) VIEWSPECS/

<.I. Word Flrst)
[*f <eee Firstd> /
'n Csoe Next)]

(SEL / ALTMODE <Accept old content> / LIT CA)
VIEWSPECS)

Confirmation;

Syntax for TNLS:

('1 <ewow

'3 <Jump tod>

Item> /

27
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1b2klkl

ib2kil

ib2kill
1b2klm
1b2kliml

Ib2kim2

I1b2k1imd

1b2kln
1b2klinl
1b2kin2
1b2kln3

lb2klo
1b2klol

1b2klel

Lb2klod
1b2klp
1b2klipl

1b2klp2

1b2klp3
1b2klg
Ib2k2

lb2k2a
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's <ees Successor> / Lb2Kk2b
"D €eee Predecessor)> / lbzkic
"u <eoe Upd> / 1b2k2d
'*d <ees Down> / 1b2k2e
'h <.e. Head> / 1b2k2f
't <esse Taild> / 1b2k2g
e <ees End of Branch> / 1b2k2h
"0 seee Origin> / 1b2k2i
"1 €eee Link> ) SEL VEIWSPECS / 1b2k2 j
"r <ses Returnd> Ib2k2k

Hhtext from next statement® S(NOT-Confirmation
%text from statement%) / I1b2k2k1

"a <eaes Ahead> 1b2k21

htext from next statement% $(NOT-Confirmation

%text from statement%) / 1b2Kk211
"f£ Cees File> 1b2k2m
('a <eess Aheadd> / Lb2k2ml
'r <oeas Return) 1b2k2m2

%file name% ${ NOT-Confirmation %next file

name%) / 1b2k2m3
"n <.s+ Name> 1b2k2n
("f <see Firstd> / 1b2k2nl
*n <... Next>) 1b2Kk2n2
(SEL / LIT CA) VIEWSPECS / 1b2k2n3
'c €sse Contentd ib2k20
(*'f <eae Firstd> / 1b2k201
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"n <... Next>) 1b2k202

(SEL SEL / ALTMODE <Accept old content> / LIT
CA) VIEWSPECS/ 1b2klod
'w C<eese Word> Ib2k2p
(2 <see Firstd> / Ib2k2pl
"n <.es Next>) Lb2k2p2

(SEL / ALTMODE <Accept old content> / LIT CA)
VIEWSPECS) 1b2k2p3
Confirmation; 1b2k2q
k (unused) lhil
1 (unused) 1b2m
move 1b2n
Syntax for DNLS: "m <Move Statement> 1b2nl

([ "o <Move onto Statement)> / "a <{Move ahead

Statement) ] 1b2nla
{TextSpecl 1b2nlal
(TextSpec2 SEL / [TextSpecl]) 1b2nlala
SEL SEL [LIiT] / lb2alalb
TextSpec?2 1b2nla2
(TextSpecl / [TextSpec2] SEL) 1b2nla2a
SEL SEL [LiT]) / ib2nla2b
[*f <ewe Filtered Statement) ] 1b2nlald
( StructureSpec2 Ib2nlada

(StructureSpecl / [StructureSpec2] SEL)
ib2nladal
SEL SEL LEVADJ / lb2nlala2
Struc tureSpecl 1b2nlaldb
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( Struc tureSpec2 SEL / [StructureSpecl ])

1b2nladbl
SEL SEL LEVADJ) / Ib2nladb2
SEL SEL LEVADJ) 1b2nlb
Confirmation; lb2nlc
Syntax for TNLS: 'c <Move) 1b2n2
([ "o <Move onto> / 'a <Move ahead) ] 1b2n2a
(TextSpecl 1b2n2al
(TextSpec2 SEL / [TextSpecl ]) 1b2n2ala
SEL SEL [LIT] / 1b2n2alb
TextSpec2 ib2n2a2
{TextSpecl / [TextSpec2] SEL) 1b2n2a2a
SEL SEL [LIT]) / 1b2n2a2b
[*f <eeo Filtered>] 1b2n2ad
( StructureSpec2 ib2n2ada
( StructureSpecl / [StructureSpec2 ] SEL)
ib2nZ2aldal
SEL SEL LEVADJ / 1b2n2aldal
Struc tureSpecl 1b2n2adb
(StructureSpec2 SEL / [StructureSpecl ])
1b2n2aldbl
SEL SEL LEVADJ)) 1b2n2aldb2
Confirmation; 1b2n2b
Semantics: 1b2n3
TextualMove [onto/ahead)] x y [LIT] ib2nJda
TextualCopy [ahead/onto] x y [LIT] Ib2n3al
TextualDelete ¥y 1b2Zndal2

StructuralMove [onto/ahead] [filtered] x y LEVADJ 1b2ndb
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StructuralCopy [ahead/onto ] [filtered] x y 1b2ndbl
StructuralDelete ¥ 1b2n3b2

NOTE: not filtered 1b2ndb2a

Example: ib2n4

move onto character word <{select character)>
{select word> ca ib2nda

the selected character is replaced by the text
of the selected word and the selected word is

deleted as in a normal delete word. 1b2n4al

new file ib20
Syntax: "n <{New File> FILENAME Confirmation3 1b2o1
Creates a new (empty) file. 1bh20la
FILENAME = SEL / LIT; 1b202
open fTile Lb2p

Syntax: "o <Open File> FILENAME [CDOT VIEWSPECS]

Confirmation; ib2pl
sﬁme as old Load file. 1b2pla

p (unused in DNLS) print (TNLS) Ib2q
Syntax for TNLS print: Lb2gl

"p <Printd> ib2gla
[StructureSpecl / StructureSpec2 SEL ] 1b2qlal

SEL 1b2gqlb

[ CDOT VIEWSPECS ] 1b2gibil
Confirmation; 1bZqlc

If no structure is specified, printing will
continue until terminated by control o or until
the end of the file is reached. Lb2qlcl

quit lb2r

J1
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replace ibls
Syntax for DNLS: "r <{Replace Statement)> lb2s1
(TextSpecl lb2sla
(TextSpec2 SEL (SEL SEL / LIT) / lb2slal
[TextSpecl] SEL (SEL / LIT)) / ib2sla2
TextSpec?2 ib2slb
(TextSpecl SEL SEL (SEL / LIT) / 1b2s1ibl
[TextSpec2] SEL SEL ( SEL SEL / LIT)) / 1b2s1b2

["f €eee Filtered Statement) ] Ib2slc
(Struc tureSpec2 1b2slcl
(StructureSpecl SEL SEL (SEL / LIT) / Ib2slcla

[ StructureSpec2] SEL SEL (SEL SEL / LIT)) /

1b2slclb

StructureSpecl 1b2slc2
(StructureSpec2 SEL ( SEL SEL / LIT) / 1b2s1c2a

[ StructureSpecl ] SEL (SEL / LIT))) / ib2slec2b

SEL (SEL / LIT)) ib2s1ld
Confirmation; Ib2sle
Syntax for TNLS: "r <{Replace> 1b2s2
(TextSpecl lb2s2a
(TextSpec2 SEL (LIT / CDOT SEL SEL) / Ibls2al
[TextSpecl] SEL (LIT / CDOT SEL)) / i1b2s2a2
TextSpec2 1b2s2b
(TextSpecl SEL SEL (LIT / CDOT SEL) / 1b2s2bl
[TextSpec2] SEL SEL (LIT / CDOT SEL SEL)) / 1b2s2b2
["f ... Filtered>] 1b2s2c
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(StructureSpec?2 1b2s2cl

(StructureSpecl SEL SEL (LIT / CDOT SEL) /

Ib2s2cla

[StructureSpec2 ] SEL SEL (LIT / CDOT SEL
SEL)) / lb2s2clb
StructureSpecl 1b2s2c2

(StructureSpec2 SEL (LIT / CDOT SEL SEL) / 1lb2s2c22a

[ StructureSpecl ] SEL (LIT / CDOT SEL))) ) 1b2s2e¢2b

Confirmation; lb2s2d
Semantics: 1b2s3
TextualReplace x ¥y ib2sJda
equivalent to 1b2s3al
NoSpacelnsert x y ib2sdala
NoSpaceDelete x Ib2s3alb
StructuralReplace [filtered] x y ib2s3b

Structurallnsert x y'y, where y' is that portion

of y which passed the filter 1b2s3bl
StructuralDelete x x 1b2s3b2
Example: lb2s4
replace word text {select word> <{select text> ca ib2s4da

the text of the selected word is replaced by

the selected text. ib2s4al
substitute 1b2t
Syntax for DNLS: 's <{Substitute Statement)> Lb2tl
[TextSpecl <... in Statement) ] lb2tla

([ Struc tureSpecl ] SEL CA / StructureSpec2 SEL
SEL CA) in2tlal

<TOTOneSel> (SEL / LIT) CA <{for TOTOneSel)>
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(SEL / LIT) CA $( NOT-Confirmation
<TOTOneSel> (SEL / LIT) CA <for TOTOneSel)>
(SEL / LIT) CA) / ib2tlala

[TextSpec2 <... in Statement) ] 1b2tib

([ StructureSpecl ] SEL CA / StructureSpec2 SEL
SEL CA) Ib2tlbl

£TOTTwoSel> (SEL / LIT) CA <for TOTTwoSel)>
(SEL / LIT) CA $( NOT-Confirmation
<TOTTwoSel> (SEL / LIT) CA <for TOTIwoSel)>

(SEL / LIT) CA) ib2tibla
Confirmation ib2tle
{Substitute in Progress> ib2tld
{Subs = NUMBER, Type CA>; Ib2tle

Syntax for TNLS: 's <{Substituted Lb2t2
[ TextSpecl <ueae ind>] ib2t2a

([ StructureSpecl ] SEL CA / StructureSpec2 SEL
SEL CA) 1b2t2al

<TOTOneSel> (LIT / CDOT SEL) CA <for

TOTOneSel> (LIT / CDOT SEL) CA $(

NOT-Confirmation <{TOTOneSel> (LIT / CDOT

SEL) CA <for TOTOneSel> (LIT / CDOT SEL) CA)

/ ib2t2ala

[TextSpec2 <aew. ind>] 1b2t2b

([ Struc tureSpecl ] SEL CA / StructureSpec2 SEL
SEL CA) 1b2t2bl

<TOTTwoSel> (LIT / CDOT SEL SEL) CA <for
TOTTwoSel>» ( LIT / CDOT SEL SEL) CA $(
NOT-Confirmation <TOTTwoSel> (LIT / CDOT SEL
SEL) CA <for TOTTwoSel> (LIT / CDOT SEL SEL)

CA) Ib2t2bla
Confirmation lb2t2c
{Substitute in Progress) Ib2t2d
<Subs = NUMBER, Type CAD; 1b2t2e
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transpose
Syntax for DNLS: "t <{Transpose Statement)>
(TextSpecl
(TextSpec2 SEL SEL SEL /
[TextSpecl] SEL SEL) /
TextSpecl
(TextSpecl SEL SEL SEL [/
[TextSpec2] SEL SEL SEL SEL) /
[*f €eee Filtered Statement> ]
(Struc tureSpec?2
(StructureSpecl SEL SEL SEL /
[StructureSpec2 ] SEL SEL SEL SEL) /
StructureSpecl
(StructureSpec2 SEL SEL SEL /
[StructureSpecl ] SEL SEL)) /
SEL SEL)
Confirmation;
Syntax for TNLS: 't <{Transpose)
(TextSpecl
(TextSpec2 SEL SEL SEL /
[TextSpecl ] SEL SEL) /
TextSpec2
(TextSpecl SEL SEL SEL /
[TextSpec2] SEL SEL SEL SEL) /

["f €eus Filtered)>)

a5

10081

1b2u
1b2ul
lb2ula
1b2ulal
ib2ula2l
ib2ulb
1b2ulbl
I1b2ulb2
ib2ule
1b2ulcl
1b2Zulcla
ibZulclb
1b2ulec2
lb2ulcla
i1b2ulc2b
1b2uld
lb2ule
1b2u2
1b2ula
1b2u2al
1b2ula2
1b2u2b
1b2u2bl
1b2u2b2

1b2ulc



CHI 14-APR-72 16:38
Suggested Changes to NLS

(Struc tureSpec?2
(StructureSpecl SEL SEL SEL /
[StructureSpec2 ] SEL SEL SEL SEL) /
StructureSpecl
( StructureSpec2 SEL SEL SEL /
[StructureSpecl ] SEL SEL)) )
Confirmations;
Semantics:
TextualTranspose x ¥
TextualCopy x y
TextualCopy ¥ x
TextualDelete x
TextualDelete y
StructuralTranspose [filtered] x y LEVADJ
StructuralCopy [filtered] x ¥y
StructuralCopy [filtered] y x
StructuralDelete x
NOTE: not filtered
StructuralDelete y
NOTE: not filtered
update file

Syntax: "u <{Update File> %default file name%

[ ALTMODE *'r <Reordered>] [FILENAME] Confirmation;

reordered Is the old output file.

viewspecs

J6

10081

1bZu2cl

1b2ulcla

1b2u2clb

Lb2u2c2

1b2uca

1b2uZc2b

1b2u2d

1b2ud

Ib2ula

1b2udal

1b2uda2

1b2udad

lb2uda4d

Lb2uldb

1b2uldbl

ib2udb2

- 1b2u3b3

1b2udb3a

1b2udb4

1b2udb4da

i1b2v

1b2vl

1b2via

i1b2vilal

1b2w
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Syntax: "v {Viewspecs> VIEWSPECS Confirmation} lb2wl
The "f viewspec will also worke. Lb2wla
window ( DNLS) Ib2x

h-split, v-split, move boundry, h—-half, v—-half,
expand, contract, expand and delete other windows,

character size. 1b2x1
x (unused) 1b2y
vy (unused) b2z
z (unused) Ib2a%*
"« (TNLS) show CM (CSP) lblaa
' Comment Lb2ab
'/ (TNLS) type context of CM (CSP) 1b2ac
" {(TNLS) print statement Lb2ad
linefeed (TNLS) print next statement Lb2ae
't (TNLS) print back statement Lb2at
SP move Current Statement Pointer ( same as Jump SP) lb2ag
"2 sets reference pointer to CM (CSP) 1b2ah

first character of the statement at top of the

display area in DNLS (with no user supplied filters

in effect). lb2ahl
TAB {TNLS) Repeat last command. 1b2ali

ALTMODE (TNLS) Jjump to next occurrance of content/word Lb2aj

(whichever was done most recently) ib2a,l
Second Llevel commands —— infrequently used commandse. 1b3
a (unused) Lbla
browse mode Lb3b
content analysis 1b3c
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device set (e.g display, TI-terminal) / delete partial
copy

edit

force case (upper / lower / initialcaps)

g (unused)

h (unused)

insert sequential

Journal (submit branch/ comment)

k (unused)

1L (unused)

merge, markers, measurement??

name delimiters,; new file

ownership, output

Syntax for output: 'o <{Output tod>

('a <{Assembler> ASSEMBLER-NAME /
'c {Compiler> COMPILER-NAME)
FILENAME Confirmation;

p (unused)

q (unused)

reset veiwspecs

status, sort

terminal Llink

undelete partial copy

verify file, viewchange (TNLS)

w (unused)

38

1b3d
1b3e
1b3r
1blg
I1b3h
Ib3i
ib3j
1b3k
1b3l
1b3m
1b3n
1b3o
1b3dol
1b3dola
lbJdolb
1b3olc
1b3p
1bdq
Lb3r
1bJds
1bJ3t
1bJu
1bdv

Lb3w
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x (unused)

y (unused)

z (unused)
susystems

a (unused)

baseline

CHI 14-APR-72 16:38

catalog, calculator ( when it happens)

debugger (when it happens)

e (unused)
f (unused)
g (unused)
h (unused)
identification
Journal

k (unused)
L (unused)
measurement
n { unused)
o (unused)
p (unused)
q (unused)
r (unused)
s {unused)
t (unused)

user programs
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1b3x
1bdy
1bdz

1b4
1b4da
1b4b
1bdc
1b4d
lbde
Ib4f
lbdg
1b4h
1b4i
1b4j
b4k
1b4l
1b4m
1b4n
lbdo
lbdp
1bdqgq
1b4r
1b4s
1b4t

1bdu
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vector package (when it happens) ( DNLS)
w (unused)
x (unused)
¥y (unused)
z (unused)
Unresolved desires
a wait and list capability for substitute
For each hity; wait for the user to ok ity and
list all hits,

Set "line" definition for a file (for line truncation).
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Lbdv
Lbdw
1b4x
1b4y

lbdz

2a
2al
2a2

2b
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(J100B1) 14-APR-T72 16:38; Title: Author(s): Charles H. Irby/CHI;
Distribution: Augmentation Research Handbook, Jacques F. Vallee, Diane
S. Kaye, Paul Rech, Michael D. Kudlick, Donald R. Cone, Don Limuti,
William R. Ferguson, Priscilla Lister; Robert L. Dendy, Linda L. Lane,
Marilyn F. Auerbach, Walt Bass, Mary S. Churchy, William S. Duvall,
Douglas C., Engelbart, Beauregard A. Hardeman, Martin E. Hardy, J. D.
Hopper, Charles H. Irby, Mil E. Jernigan, Harvey G. Lehtman, John T,
Melviny, Jeanne B, North, James C. Norton, Cindy Page, Bruce L. Parsley,
William H. Paxton, Jeffrey C. Peters, Jake Ratliff, Barbara E. Row, Ed
K. Van De Riet, Dirk H. van Nouhuys, Kenneth E. Victor, Donald C.
Wallacey Richard W. Watson, Don I. Andrews,; L. Peter Deutsch, James G.
Mitchell/SRI—ARC LPD JGM; Sub—Collections: SRI-ARCj; Clerk: CHI;
Origin: <{IRBYD>NEWPARSER.NLS;50, 14-APR-72 16:35 CHI 3



WLB L7-APR-72 12:32 10082
Concerning the ideant "NICY

The ident "NTC" should be used for reaching NIC staff —— not for
reaching everyone In the NET. Is there a good reason for this
not to be the case?
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(J10082) 17-APR-T72 12:32; Title: Author(s): Walt Bass/WLB;
Distribation: Richard W. Watson, Jeanne B., North, James C. Norton/RWW
JBN JCN3 Sub—-Collectlions: SRI-ARC; Clerk: WLB;
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helle echo back

hello,; bruce;

1 got your journal message last night., it somehow seems
appropriate that the nic was down for a week, right during the
time everyone was (and is) upset about server reliability.
anyhow, tanx for the test, next time steve sends me a message
saying I can stay at cordell's, i'll get it before going up to
sri.

how'!s the weather and all that?

bye now.
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hello echo back

(J10084) 17-APR-T72 14:15; Title: Author(s): David H. Crocker/DHC;
PDistribution: Bruce A. Dolan/BAD; Sub—Collections: NIC; Clerk: DHC;



Mark C. Krilanovich
University of California at Santa Barbara
Computer Center

) Santa Barbara, California 93106

To:z
Access Copy

10085
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Comment on the NIC

(J10085) 17—-APR-72 14:283 Title: Author(s): Mark C. Krilanovich/MCK3;
Distribation: Mark C., Krilanovich/MNMCK; Sub—Collections: NIC; Clerk: MCK3;
Origin: <UCSB>MCK.NLS;3;1, 17-APR-72 10:56 MCK ;
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Comment on the NIC

far out —— the NIC is back up again...



Walt Bass

Augmentation Research Center
Stanford Research Institute
Menlo Park, California 94025

To:
Access Copy

10086
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(J10086) 17—-APR-T72 14:35; Title: Author(s): Walt Bass/WLB;
Distribution: Augmentation Research Handbook,; Jacques F. Vallee, Diane
S. Kaye, Paul Rechy, Michael D. Kudlicky Donald R, Coney; Don Limuti,
William R. Ferguson, Priscilla Lister, Robert L. Dendy, Linda L. Lane,
Marilyn F. Auerbach, Walt Bass, Mary S. Church, William S. Duvall,
Douglas C. Engelbart, Beauregard A. Hardeman, Martin E. Hardy, J« Da.
Hopper, Charles H., Irby, Mil E. Jernigan, Harvey G. Lehtman, John T.
Melvingy Jeanne B, North, James C. Norton, Cindy Page, Bruce L. Parsley,
William H. Paxton, Jeffrey C. Peters, Jake Ratliff, Barbara E. Row, Ed
K. Van De Riet, Dirk H, van Nouhuys, Kenneth E. Victor, Donald C.
Wallace, Richard W, Watson, Don [I. Andrews/SRI-ARC; Sub—Collections:
SRI-ARC3; Clerk: WLB;

Origin: <BASS>PODCOM.NLS3;1, 17-APR-72 14:29 WLB ;
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)REPORT ON PODCOM MEETING 10 APRIL 1972
Present:

Cedar: KEV PR

Fir: MEJ JTN

Oak: WLB JDH

Redwood: MDK

This was the first meeting of PODCOM following a decision to
change its organization and mode of operation.

PODCOM now has a chairman (currently WLB) who is responsible
for seeing that matters which are brought before PODCOM
receive due consideration, with some decision being reached
and promulgated —— this in response to a general complaint
that PODCOM typically has jumped from one issue to another
without ever resolving any of them.

Doug will ne longer automatically attend all PODCOM meetings,
but only when he wants to bring something before PODCOM or is
regquested to come s0o as to answer gquestions,; resolve
ambiguitles, set policy, etc.

PODCOM will be responsible for overseeing the POD Activity and
implementing established PODAC policy; fostering inter—POD
communicationy, and seeing that the lines of communication
between Doug and the PODs remain open. The gquestion of how
PODAC pollicy comes to be established remains open; basically,
Doug will be held responsible for overall policy decisions,
and PODCOM will attempt to guide Doug in making these
decisions and will set policy itself (in a domain yet to be
specified) with the advice and consent of Doug.

The question of ARC seminars was brought up agailn, and the
following actions were taken so as to make it possible for PODCOM
to procede to other issues:

Since no agreement could be reached on what exactly should be
the dividing line between seminars which are the province of
PODAC and seminars which are the province of LINAC, and since
it seemed that most of the seminar topics which had been
proposed probably fell into the province of LINAC, it was
declded to table the issue of appointing a PODAC Seminar
Coordinator until some new developments made the issue viable.

2a

2b

2c

2d

Ja

Jb

3c

4a
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Report on PODCOM Meeting 10 April 1972

PODCOM hereby strongly suggests that LINAC soon appoint a
Seminar Coordinator who will be responsible for coordinating
facilitiesy resources, and scheduling for seminars which are
relevant to the pursuit of LINAC goals. This would include
ARC seminars by ARCers,; non—ARC seminars by ARCers, and ARC
seminars by non—ARCers, There was disagreement within PODCOM
regarding the question of whether the Seminar Coordinator
should also be a Seminar Pusher, responsible for pushing his
fellow ARCers to give and attend seminars.

PODCOM will attempt to serve as coordinator for any seminars
which are clearly relevant to the pursuit of PODAC goals until
such time as there is a distinct PODAC Seminar Coordinator.,

Several issues related to the hiring and encul turlzation (?) of
new ARC members were discussed.

Paul and Mike felt that they had not been adequately warned
about what to expect at ARC in the way of pressures to adapt
to the atmosphere of social experimentation — e.g.y PODs and
our unorthodox management structure.

It was agreed that potential new employees were entitled to a
"full disclosure" of the conditions which would be Iimposed
upon them as members of ARC and that such a disclosure would
be of great value to ARC itself Iin helping to prevent
avoidable misunderstandings.

Several mechanisms for guaranteeling this full disclosure were
discussedy; and it was finally decided that PODCOM should
prepare a brief document,; perhaps in the form of a checklist,
covering issues which PODCOM feels should be discussed with
potential hires, This document would be given to individuals
which are responsible for coordinating interviews for
applicants with the hope that they would check with each
applicant before he leaves the interview to be sure that all
the items on the checklist have been discussed with and are
understood by the applicant,

We also discussed the question of how interviews are set up
for applicants and agreed that It should be the responsibility
of LINAC to designate some individual as being "responsible"
for that applicant. In addition to seeing that the applicant
receives the information described above, he should see to it
that all ARC members are made aware of the facts of the
interview so that they can schedule a talk with the applicant
on the day of the interview; iIf they are so inclined.

A similar procedure should be followed for all other

4b

4c

Sa

Sb

Se

Sd
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visitors so that everyone who might be interested in
meeting with a visitor knows of the visit far enough in
advance to make appropriate arrangements. 5dl

We did not go deeply into the question of whether an ARCer
could/should be excluded from talking with an applicant or of

how a given ARCer's objections to a specific applicant

are/should be weighted — perhaps some discussion of these

toples by the PODs would be useful. Se

It was agreed that seminars given by applicants form a very

useful role in the interview process and should become more

common, particularly in the case of more experienced

applicants. St

Several items of general interest regarding PODAC were discussed. 6

It was agreed that the ad hoc methods by which new ARCers were

being assigned (?) to PODs should not continue and that this

was an appropriate function for PODCOM to perform.

Henceforthy, PODCOM will take the responsibility for making

these assignments, and anyone wishing to influence the

assignment process should make their wishes known to their

PODCOMN representative. 6a

We briefly discussed the following issues and agreed that

PODCOM should take no position on them until they have been

discussed in the PODs so that the members of PODCOM could have

a broader basis of understanding and consensus on which to

base their stands: 6b

How many PODCOM representatives should each POD have (1 or

2) and how should they serve (permanent or rotating)? One
favorite scheme was that there be 2 PODCOM representatives,

one rotating and one permanent (i.e., long rotation perlod)

with an additional provision that both representatives

could not be changed at the same PODCOM meeting (so as to

preserve some continuity). 6b1

Should one POD be able to invite a member of another POD to
Join 1t? If so how do you handle the resulting imballance
in POD size (by "exchanging™ members?)? 6b2

How should POD membershlp evolve In general? (The three
month POD trial period will soon be up, and this is a very
relevant question to consider at this time.,) 6bJ

Should night—-shift employees ( Ralph Prather is a specific
example) be invited to join a POD? (It was generally
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agreed that It would be unreasonable to EEQUIRE this of

employees who work non—standard hours, but we need to know

whether most ARCers would want such employees to belong to

a POD and, if noty whether a regquest to Jjoin a POD by such

an employee should be denied,) 6b4



DCE 17-APR-72 14:47 10087
Discussion Log: 17 Apr 72, Bob Peters, SRI, on promoting cable TV
utilization research at SRI, voting, teaching,; shopping, etc.

Bob (Ext., 3030) is involved with Cable TV, in various ways. He
1s looking into the possibilities of SRI putting together a
coordinated program toward developing techniques for harnessing
the two—-way video communication potential. Wonders what sort of
relatedness we see to our work, and what our inerest might be iIin
getting involed.

I tell him of our basic ailm to work with the system developers
of such systems,y; rather than with thei systems' development, and
that if SRI did set up a developmental program in this area, we
would like to have that development group be one of our
Bootstrap Communnity participants (being one of a community of
system developers who get various kinds of support from this
participation).

Bob is trying, for instance; to bring to SRI some people from
granting agencies, as a way to begin exploring the funding
possibilities for SRI's getting into thi business. Would like to
bring such people by AARC to show some of SRI"s experince and
developments in areas related to the problem,

That would be fine with me; I would like to support such
need within the Instlitute. I would suggesty though, that
someone like Dave Brown handle the people who thus might come
through —— he is in sort of a good "middle" position, and it
is highly likely that the system development part of any such
program would (should) be done in his labe.



DCE 17—-APR-T72 14:47 10087
Discussion Log: 17 Apr 72, Bob Peters, SRI, on promoting cable TV
utilization research at SRIy voting, teaching, shopping, etc.

(JIDOBT) L7-APR-T72 14:47; Title: Author(s): Douglas C, Engelbart/DCE;
Sub-Collections: SRI—ARC; Clerk: DCE;
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THE NEXT STEPS IN PLANNING

This journal entry follows (10035, ), disseminates changes made
in the outline at the meeting on Wednesday, 12 April, spells
out working procedures agreed upon for assembling the report,
and provides more detaliled schedules.

MASTER SCHEDULE AND BROKENDOWN SCHEDULES

I have added to the master schedule (10035,3:v) time for
assembly and review of the parts and links to schedulejls for
sections Ily IV, V broken down one level finer in outline.

The Section Schedules also appear below., On the schedule A
means assembly, R means reviewy, and XV means reworks.

WHAT TO DO WHEN WHAT YOU HAVE WRITTEN IS READY FOR REVIEW

The section file Iin {documentation> contains the corresponding
part of the outline, e.g.y {(documentation, section-T,Iw).

When your piece Is ready for review, replace the statement
with your contribution as a branch and tell the reviewer(s)
and me.

REVIEW

Reviewer: please consider the section you read for accuracy
and appropriateness and discuss your thoughts with the author.

AFTER REVIEW

The author make any changes agreed upon between you and the
reviewer and tell me when the version in a documentation
sectlon file is agreeable to both.

LINKS

Feel free to use links to other parts of the report —-- an
analyzer formatter program will replace them him citations in
the printed version. It's ok to use links to online documents
that are not part of the reporty, but do not base your argument
on them., Many important readers will not be online,

AUTHORSHIP

Our most recent report (8277,) named no author on the title
page; for journal purposes the author was ARC, The next
previous report, that to NASA dated February 8, 1969, named
D.C. Engelbart and staff., Earlier reports, which had less of

la

2a

Jda

da
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the character of integrated team efforts, had up to three
named authors, 7a

Dick Watson has strongly urged that the usage of the last two
updates is too anonymous to ensure proper professional credit. b

We could list all of you who made an intellectual contribution

to the research reports as authors of the complete report.

Such is the practice in some fields such as high energy

physics where papers often have ten to twenty authors. Tc

Perhaps it would be more meaningful to list the authors

section by section, Td
Please tell me your ideas., Te
REFERENCES 8

Please pass references to offline documents, NIC or otherwise,
to me. Ba

APPENDICES 9

The report may invovle many and bulky appendices. We plan to

have separate appendices for each section. When your appendix

is finished, please put it In the appropriate section file in
{documentation> with links back and forth between the appendix

and the text it supports, 9a

(Contents )(entry JOUTLINE

Link to master schedule ( ,S:BnDxbbbrr) 10
Head Matter (MEJ) <DVN> Pages=5 10;
Abstract (DVN) <JCN> Pages =1 10b
Summary (DVN) <{JCN> 10c

Background on ARC Pages =1 10el
Structure of this report Pages =1 10c2
Summary of Content 1970 Report Pages =1 10c3
Summary of Content 1971 Report Pages =1 10c4

I Team Augmentation
Link to brokendown schedule ( ,Isc:BnDw)
Link to Documentation file (documentationysection—i,3ixb) 10d
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DSS (WSD) <JCN> Pages =10 10d1
Journal 10dla
Journal Catalogs 10dlb
Ident System 10dlc
Number System 10dld

Handbook (MFA) <JCN> 1042
Contents Pages =30 as appendix 10d2a
Description Pages= J 10d2b

BRS (JCN) <DVN>Pages= 5 1043

Basic NLS(CHI) <JCN> 10d4
User Features (CHI)Pages =15 10d4a

Sort/Merge (JDH) 10d4al
Split Screens (CHI) 10d4a2
Cross File Editing (CHI) 10d4a3d
User Programs ( HGL) 10d4a4
Output Processor 10d4aS
Control File 10d4ab
Dex (HGL) 10d4a7
TNLS (MFA /HGL) 10d4a8
. 10d4a9
. | 10d4a10
. 10d4all
Languages ' 10d4b
L10 (HGL) Pages =5 10d4bl
Tree Meta ( HGL) Pages=10 10d4b2
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MPS (WHP) 10d4c
Internal organizationrt 10dS
Team Structure( JCN) <DVN> <RWW> Pages =5 10d5a
POD Activity(JDN,DVN) <JCN> Pages =2 10d5b
1046

II NIC Development and Operations ( RWW) <JCN>Pages = 20
( documentationysection—1II,2xb) 10e
- 10el
. 10e2
- 10ed

IITI Network Participation ( RWW) <JCN)>Pages=10

( documentationysection—I11I,xb) 10r
Working Group Participation 10£1
System Software 1012

IV Computer Facility
Link to Documentation file (documentationysection—iii,Ixb)

Link to brokendown schedule ( ,IVsc:BnDw) 10g
Hardware (JCN) <DVN,EKV>Pages=10 10gl
Summary Description 10gla
RPO-2'S 10glal
Terminals 10gla2
PDP-10 10glad
Printer 10gla4
Display System 10glas
X—core 10glab
Bryant Drum 10gla?
UNIVAC Drums 10gla8
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BBEN Network Interface 10gla9

BBEN Pager 10glalo
Problems 10glb
Plans Pages=5 10glbl
System Software (DCW) <JCN> Pages=10 10g2
IMLAC (CHI) 10g2a
TENEX 10g2b
User Features 10g2c
Superwatch ( DIA) 10g2d

V Plans <DVN>
Link to brokendown schedule ( ,Vsc:BnDw)

Link to Documentation file (documentation,section—V,;ixb)( 10h
Project (JCN) ( journal,7404,:x) Pages=5 10hl
Bootstrap Community ( DCE) Pages=5 10h2

Glossary (DVN) <MFA> Pages=4 10i

Index (MEJ )XDVN>Pages =5 10

Appendices (?) 10k

MASTER SCHEDULE 11

SCHEDULE Abs Sum SEC SEC SEC SEC SEC Refs Glos
indx

trct mary 1 IX III iv v sary
L B B B L a® 8 s s L A LE N - e 88 s L B - e e e - e % e e e %8 - e
-

{yIsc) (¢yIVsc) ( 4Vsc)

APRIL
Week 3
Monday A see A A see see
Tues A brk A A brk brk
Wednes A down A A down down
Thurs A A A
Friday A A A
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Veek 4
Monday
Tues
Wednes
Thurs
Fri

A

MAY
Week 1
Mon A A R A A A
A

Tues A A 4 A A A
A

Wednes A A R A A A
A

Thurs A A R A A A
A

Friday A A R A A A
A

Week 2 Review ..staggered to avoid spot overload

Monday R R X R A R
A %
Tues R R X R A R
A

Wednes X R X R R R
A

Thurs X R X R R X
A

Friday DUE R R X
A

Week J Rewrite reviewed sections

Monday DUE X X X X
P oFE

Tues X X X DUE
R

Vednes X X X

X

Thurs X X DUE

X

Friday DUE DUE

DUE

WVeek 4

Monday e«eeesesessorseeeseesbBegin FINAL

PRINTING/MASSAGE =

Tues

Vednes

Thurs

Friday

JUNE

>
i
>y
E
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Week 1

Mon P2O20202055>>>>>Begin SRI EDITING AND APPROVALKCLLLLLLLLLLLLKL
Tues

Wednes

Thurs

Friday

Week 2

Tues

Wednes

Thurs ——=—=—————=COMPLETED REPORT (AS A FINISHED DRAFT) DUE IN
ROME
SECTION I BROKENDOWN SCHEDULE
SCHEDULE DSS Hand BRS NLS ORG

book v v
-8 e s aw L B I -® 8 s -e a9 - e 9% @8 L B L B ] LR B N ] -8 sas -am e s - "
APRIL
Week 3
Monday A A A A A
Tues A A A A A
Wednes A A A A A
Thurs A A A % A
Friday A A A A A
Veek 4
Monday A R A A A
Tues A R A A A
WVednes A R A A A
Thurs A b A A A
Fri A X A A A
MAY
Veek 1
Mon R X A A A
Tues R X A A A
Wednes R DUE A A R
Thurs R A A R
Friday R A A ®
Veek 2 Review ..staggered to avoid spot overload
Monday X R R X
Tues X R R X
Vednes X R R DUE
Thurs X R R
Friday DUE R R
Week 3 Rewrite reviewed sections
Monday X X
Tues X X
Wednes X X
Thurs X X
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Friday DUE DUE

Veek 4

Monday - - - Begin FINAL
PRINTING /MASSAGE —

Tues

Vednes

Thurs

Friday

JUNE

Week 1

Mon D3>3335>335>>>>>>Begin SRI EDITING AND APPROVALC<<<<<<<KLKLKLKL
Tues

Wednes

Thurs

Friday

Veek 2

Tues
Vednes
Thurs COMPLETED REPORT (AS A FINISHED DRAFT) DUE IN
ROME-
SECTION IV BROKENDOWN SCHEDULE
SCHEDULE Hard Soft

ware ware

e 9 " 888 LE B N ) -e & 88 LR LE N I N aes se s - e e a8 -a®eae LR N N LA ] LI

-
APRIL
Week 3
Monday
Tues
Wednes
Thurs
Friday
Week 4
Monday
Tues
¥Fednes
Thurs
Fri
MAY
Veek 1
Mon
Tues
Wednes
Thurs
Friday
Week 2 Review ..
Monday R
Tues R

Ll
L

>
>

>y

taggered to avoid spot overload

“HKb XKD
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Wednes R X

Thurs R X

Friday R DUE

Week J Rewrite reviewed sections
Monday X

Tues X

Wednes X

Thurs X

Friday DUE

Week 4

Monday - +~«Begin FINAL
PRINTING /MASSAGE

Tues

Vednes

Thurs

Friday

JUNE

Week 1

Mon 2>D>>2>23>>2>>>>>>D>>Begin SRI EDITING AND APPROVALC<CLLLLLLLLLLLLKL
Tues
Wednes
Thurs
Friday
Week 2
Monday —-———————%%%%%%%¥DRAFT DUE IN MAILD??2222d@@d========———-—
Tues
Wednes
Thurs ————————==COMPLETED REPORT (AS A FINISHED DRAFT) DUE IN
ROME
SECTION V BROKENDOWN SCHEDULE
SCHEDULE Pro Boot

Ject strp

L - e eamn ae ® e -e eoa s L L B LR I N LR B ] LA -a s as - 9

APRIL

Week 3

Monday A A
Tues A A
Wednes A A
Thurs A A
Friday A A
Veek 4

Monday A A
Tues A A
Wednes A A
Thurs A A
Fri A A
MAY

Week 1
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Mon R A
Tues R A
Vednes R A
Thurs R A
Friday B A
Week 2 Review .,.staggered to avoid spot overload
Monday X R
Tues X R
Wednes X R
Thurs X R
Friday DUE R

Week 3 Rewrite reviewed sections
Monday X

Tues X

Vednes ) %

Thurs ) 4

Friday DUE

Week 4

Monday . -ttt g Begin FINAL
PRINTING /MASSAGE
Tues

Wednes

Thurs

Friday

JUNE

Veek 1

Mon 22222205535 >>>>Begin SRI EDITING AND APPROVALLLLC{LLLLLLLLLL
Tues

Wednes

Thurs

Friday

Week 2

Monday ————————%X%ikXkLEEkDRAFT DUE IN MAILL?2222ddddd=======—————
Tues

Wednes

Thurs COMPLETED REPORT (AS A FINISHED DRAFT) DUE IN
ROME

10



DVN 17-APR-72 16226 10088
1971 Report to Rome: revised schedulejsoutline, and procedures

(J10088) 17—APR-72 16:263 Title: Author(s)z Dirk H. van Nouhuys/DVN;
Distribution: James C, Norton, Marilyn F. Auerbach, Duane L. Stone,
Charles H. Irbyy Harvey G. Lehtman, Richard W. Watsony J. D. Hopper, Ed
K« Van De Riety Don [I. Andrews, Donald C. Wallace, William S. Duvall,
Dirk H. van Nouhuys/JCN MFA DLS( for your information) CHI HGL RWW JDH
EKV DIA DCW WSD DVN; Sub—Collections: SRI-ARC; Clerk: DVN;

Origin: <VANNOUHUYS>ROMET71.NLS337y 17—APR-72 16:14 DVN ;
vannouhuyssdvn,#1)



(HJOUENAL§;39§§.NL831, 17=-APR=T72 18:33 XXX ; Title: Author(s): bDirk
Ha van No ¥8/DVN; Distribution: James C. Norton,-Marilyn F. Auerbach,
Duane L., Stuone, Charles H. Irby, Harvey G. Lentman, Richard W. Watson,
J, L., Hopper, Ed K. Van De Riet, Don I. Andrews, Donald C. Wallace,
William S, Duvall, Dirk H. vzn Nouhuys/JOCN MFA DLS(for your information)
CHI HGL RWW JDH EXKV DIA DCW WSD DVN; Sub-Collections: SRI=ARC; Clerk:
DVN;

Origin: <{VANNOUHUYSPHOMETL.NLS3;37, L7-APR~-T72 16:1l4 DVN ;
vannouhuys,dvn, #1)



DVN 17=~APR=T72 16:26 10048
1971 Report to Home!: revised schedule,cutline, and-procedures

THE NEXT STEPS IN PLANNING

This Jjournal entry follows (10035,), disseminates changes made
in the outline at the meeting on wWednesday, 12 April, Spells
out working procedures agreed upon for assembling the report,
and provides nore detailed schedules,

MASTER SCHEDULE AND BROXENDOWN SCHEDULES

I have added %o the master schedule (10035,:v) time for
assenbly and review of the parts and links to schedulejls for
sections II, IV, V broken down one level finer in outline,

The Section Schedules also appear belowWw, On the schedule A
means assembly, R means review, and XW means reworke.

WHAT TO DO WHEN WHAT YQU HAVE WRITTEN IS READY FOR REVIEW

The sesction file in <documentation) contains the corresponding
part of the outline, e.g., (documentation, section=I,:w).

When your pilece is ready for review, replace the statement
with your contribution as a branch and tell the reviewer(s)
and ne,

REVIEW

Heviewer: please consider the section you read for accuracy
and approvriateness and discuss your thoughts with the author.

AFTER REVIEW

The author make any changes agreead upoen petween you and the
reviewsr and tell me wnhen the version in a documentation
section file is agreeable to both,

LINKS

Feel free to use links to cther parts of the report =- an
analyzZer formatter program will replace them him citations in
the printed version., 1It's ok to use links to online documents
that are not part of the report, pbut do not base your argunent
on them, HMany important readers will not be online.

AUTHORSHIP

Gur most recent raport (8277,) named no auther on the title
page; for journal purposes ithe auythor was ARC. The next
previous report, that to NASA dated February 8, 1969, named
D.C. Engelbart and staff, Earlier reports, which had less of

B %Mw%ﬁ
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the character of integrated team efforts, had up to three
named authors. Ta

DicKk Watson has strongly urged that the ugage of the last two
updates is too anonymous to ensure proper professional credit. b

we could 1list all of you who made an intellectual contribution

to the research reports as authors of the complete report.

Such is the practice in some fields such as high energy

physics where papers often have ten to twenty authors. Ta

Perhaps it would be more meaningful to list the authors

section by sectiocn. Ta

Please tell me your ideas. Te
REFERENCES 8

Please pass references to offline documents, NIC or otherwise,

Lo me. ga
APPENDICES g

The report nay invovle nany and bulky azppendices. We plan to

have separate appendices for each section. 4Yhen your abppendix

is finished, please put it in the appropriate section f£ile in
{documentationd with 1inks back and forth petween the appendix

and the text it supportis. 9a

{Contents) (entry)QUILINE

Link to master schedule (,S:BnDxbbpbrr) 10
Head Matter (MEJ) <DVN> Pagess 10a
Abstract (DVH) <JCN> Pages =1 100
sumnary (DVN) <JCN>» l0c

Background on ARC Pages =1 10Ed.
S%ructure of this report Pages =1 10c2
Sunmary of Content 1970 Report Pages sl 10e3
Summary of Content 1971 Report Pages =1 loch

I Team augmentstion
Link to brokendown schedule (,Isc:BnDw)
Link to Documentation f£ile (documentation,section=i, 1xb) 10d
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DS8 (WsD) <JCN> Pages =10 l0dl
Journal 1l0odla
Journgl Catalogs l0dlp
Ident 3ystem 1l0dlc
Number Systen l0dld

Handbook (MFA) <JCN> 1042
gcontents Pages =30 as appendix ' lod2a
Description Pages= 3 10d2b

BRS (JCN) <DVN>Pages= 5 10d3

Basic NLS(CHI) <JCN> 10d4
User Features (CHI)Pages =15 10dha

Sort/Merge (JDH) 10dhal
Split Screens (CHI) lodha2
Cross File Editing (CHI) | 104423
User Pr‘oe:rams 10dhal
Output Processor 10dhas
Control File 10dhaé

Dex @ 10d4a7
TNLS {MFAJiEiii:) 104428

- 10cdha9
. 10dkalo
. 10dhall
rangiuages 1loalo
L10 Lodhbl
Trea Meta 10dhb2




DVN L17=APR=-T72 1l6:26 10084
L1971 Report to kHome: revised schedule,putline, and procedures

MPS (WHP) lodhe
Internal organizationrt 10d5
Team Structure(JeN) <DVN> <RWW> Pages =5 lodba
POD Activity(JDN,DVN) <JCN> Pages =2 lodsb
1046

IT NIC Developnent and Operations (RWYW) <JCN>Pages = 20
(decumentation, section=~II, :Xbh) 1oe
o 10el
B 1l0e?2
B 10e3

IIT Network Participation (RWW) <JCND>Pages=)0

{documentation,section=II1I,xb) 1l0z£
Working Group Participation 1ol
System Software 10f£2

1V Cenputer Facility
Link to Documentation file (documentation,secticn=-iii,:xb)

Link to brokendown schedule (,IVsc:snbw) 10g
Hardwayre (JCN) <DVN,EKV>Pages=l0 10gl
Summary Description | logla
RPO=215 10glal
Terminals 10gla2
PDP=10 10gla3
Printer 10elal
Display 8ystem 10gla5s
X=core 10plasdé
Bryant Drum 10glaT®
UMIVAC Drunms 10glad
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BBa&N Network Interface 1021a9

BHB&N Pager 10glalQ
Problens l0glp
Plans Pages=5 10g1lbl
System Scftware (DCW) <JCN> Pages=1lO 10g2
IMLAC (CHI) 1l0g2a
TENEX 1l0g20b
User Features 1Lggze
Superwateh (DIA) 10g2d

V Plans <DVND>
Link to brokendown schedule (,Vsc:Bndw)

Link to Documentation file (documﬂntatlon sectlon- s 2Xb) ¢ 1.0n
Project (JCN) (journal,?hou,:x} Pagess=h 10nl
Bootstrap Community (DCE) Pages=5 10h2

Glogsary (DVN) <KMFA> Pageg=l 101
Index (MEJ)LDVN>Pages =5 107
Appendices (?) 10K
MASTER SCHEDULE 11

SCHEDULE Ab=s 5um SEG SEC SEC SEQ SEC Rafs Glos
indx

tret mary i IT ) Iv v sary
.l.ﬁ.t.l.-’n!i.@"‘1'!!3!1I0.0"18I!‘lll.lll.IQOD.HlHQ.ﬁ'zC.i..A!-
{4 Tac) {,IVace) (,Vsc)

APRIL

Week 3

Monday |} ! A lgee 1 A | A | see | see | | l
Tues ! booA& texk L A | A & Bk i Brk | ! i
Wednes ! i A ldown I A | A | down | downl { :
Thurs | i & ! A 1 4 1 ! { i {
Friday ! } & 1 1 & | A 1 | i l l



DVN 17=APR=72 16:26 10088
1971 Report to Rome: revised schedule,outline, and procedures

Week L
Monday
Tues
Wednes
Thurs
Fri
A
MAY
Week 1
Mon ! A 3 4
A
Tues & A
A
A
A

= G= P P
— = = —
e
= e g G G
P
= err
—— — f— — S
PR B T S
— = = = S
— = — = D=
=r e
— — e S E—

Wednes | A |

A

Thurs § A |

A

Fridey ! & | A | !

A

Week 2 Review ,.staggered to avoid spot overload

Monday ¢ R | R | i ! ! { ! A | R |

A

Tues ! B 1 B 1 i

A

Wednes | X ! R | 1

A

Thurs [ X | R ! ! i B} 1 I B 1 =

A

Friaay | ] ! ! DUE | X

A

Week 3 Rewrite reviewed sectlions

Monday | DUE § X | | I X

B

Tues 1 L X i | T

R

Wednes | i X H O O | i £ X I i
X

3>
-
> > >

l l ! A ) !

T W w

oA & ¢ R & 3

R
I R | Il A | R l
R

! ! { | R | R }

S - S e

O
-
-—
QO

X
Thurs | I S ! {
X

Friaay | ! DUE | i ! DUE ! : l l l
bug

Week U

Mongday ee¢eertbererteeeeeeBagin FINAL

PRINTING/AMASSAGE ww oo oww o

Tues ! :
Wednes |
Thurs |
Friday |
JUNE

e
-—

B M - W
—— = a— e—
B w— o= G—
e e g B
= g = —
= = = B

= g -
= -

A% 3



DVN 17=-APR=72 16:26 10088
1971l Report to Rome: revised schedule,outline, and procedures

Week 1
Mon D220 20509>>»>>Begin SRI EDITING AND APPROVALCCLLLLLLCLLKLKL
Tues ! | ! : l | | !
Wednes |
Thurs !
Friday |
Wesak 2
Monqay =wemm==== sewunduntDRAFT DUE IN MAILGSR2E8R2E2238csssszidemmmn
Tuas ! i { ! ! | { 1 ! !
Wednes | d | | ! l { ! ! {
Thursg =rer-=acema= COMPLETED REPORT (AS A FINISHED DRAFT) DUE IN
FOME mm e vm o o o e om0 10 v o e
SECTION I BROKENDOWN SCHEDULE
SCHEDULE D38 Hand BRS NLS ORG

book v 1

'..".Ol.DI..il.'-I!l..‘lIII.Q.II"'II'O.-..l."'.l.""l""'l'.

|
l }
! '
| l

!
| | i
| l |
| | l

o= B §—
—
B

»—

APRIL
Week 3
Monday
Tues
Wednes
Thurs
Friday
Weak L
Monday
Tues
Wednes
Thurs
Fri
MAY
Week 1
Mon
Tues
Wednes
Thurs
Friday
Week 2
Monday
Tues
Wedhes
i
Thurs
Friday
Weak 3
Monday
Tues
Wednes
Thurs

P
o

— = = e
PNRCONS S
— E— G — R—
x>
e G s G B
= = — B S
T
T g G- -
B s (e —
B G e o -
LR S

= e k- ==
- — O

EEEeRE bEbED

L e e
=
e e = = B
i R vl v - of
— e e =
- -
B fum o= = P
P— ae = - =
— - B = B
B e e e S

B Do = P P
e S e e B

o
o > X

=l
e e e
ol
— g G- —
b v v B w e - g
e Do e -
g = B S
G = B
A e R —

1
ed to aveid sp
! I X

b X
{ DUE !

!

%t overload
l ! !
l l l !

I e= o= #— 5— a—

g
=
=

1]
<
el - el v - 3R v e o - v

e SLAREES

= o= ) o— o= — — a—

Faliev il slie B

G = =
= = o=
afihe e Jio sl

e g s ) b= = v e —
B
.—
—

X 3 !
DUE ! | R
ewrite reviewed
1 |

Y G = g O A— =
a
4]
- e a= (] == o
N
Fes
e - o
]
o
— e = = [ — »—
r—
—
o
— = = e -—
W= B e — -

20PN g
= g = -
= e - o—
b B = B

i
!
!

— - -



DVN 17~APR=T72 Ll6:26 10068
157) Report to Rome: revised schedule,outline, and.procedures

Friday | ! { DUE 1 Duwm | ! { l ! l
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Wednes 1| R | X i ! ! i i i ! i
Thurs 4 kB F X | ! ! { ! l { )
Friday ! R | pum i I i ! ! ! ! !
Week 3 Rewrite reviewed gections

Monday | X | ! l ! ! ! ) i !
Tues A | ! 1 | 1 | ! ! l
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Thurs 1 X 1 { l l | ! ! | !
Friday | DUE ! ! ! ) l l ! ! !
Week I
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THE NEXT STEPS IN PLANNING

This Journal entry follows (10035,), dissSeminates changes made
in the ocutline at the meeting on Wednesday, 12 April, spells
out working vrocedures agreed upon for assembling the report,
and provides more detailed schedules.

MASTER SCHEDULE AND BROKENDOWN SCHEDULES

I have added %o the master schedule (10035,:v) time for
assembly and review of the parts and links to schedulejls for
sections 11, IV, V broken down one level finer in outline,

The Section Schedules alsc appear below. On the schedule A
neans assembly, R means review, and XW means rewyerk.

WHAT TO DO WHEN WHAT YOU HAVE WRITTEN IS READY FOR REVIEW

The section file in <documentaticn) contains the correspondinz
part of the outline, €.f., (documentation, section-I,:wW).

When your piece is ready for review, replace the statemnent
with your contributicn as a ovraneh and tell the reviewer(s)
and ne,

REVIEW

Seviewer: please consider the sectlon you read for accuracy
and appropriateness and discuss your thoughts with the auther,

AFTER REVIEW

The autiior make any changes agreed upon bestween you and the
revievwer and tell me when the version in a docunentavion
section file is agreeabple to bouh.

LINKS

Feel free to use links to other parts of the report == an
analyzer formatter program will replace them him citations in
the printed version. It's ok to use links to online documents
that are not part of the report, put do not pase your argunent
on tnem. Many important readers will not be online.

AUTHCORSHIP

Our most recent report (8277,) named no author on the title
page; for Jjournal purposes the guthor was ARC. The next
previous revort, that to NASA dated February 4, 1969, nanmned
D.C. Engelbart and staff. Earlier reports, which had less of

la

2a

sa

o

643
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the character of integrated team efforts, had up to three
named authors.

Dick Watson has strongly urgea that the usage of the last twe
updates is too znonymous to ensurs proper professional credit,

we could list 21l of you who made an intellectuzl contribution
to the research reports as authors of the complete report,
Such i3 the practice in some fields such as high energy
physics where papers often have ten to twenty authors,

Perhaps it would bhe more meaningful to list the authors
secticn by section.

Please 1tell me your ideas.

REFERENCES

Please pass references to offline documents, NIC or otherwise,
to ne.

APBENDICES
The report may invevle many and bulky appendices. We plan to
have sSeparate appenaices for each section. When your appendix
i3 Iinished, please put it in the appropriate section file in
{documentation) with links back and forth between tie appendix
and the texXt it Supports.

(entry) QOUTLINE
Link to master schedule (,3:HnDXbbbrr)

Head Matter (MEJ) <DVN» Pagessh
Abstract (DVN) <JCN> Pages =1l
summary (LDVN) <JOND>
Background on ARC Fagem =1
Structure of this report Pages =1
sumnmary of Content 1970 Report Pages =1
Summary of content. 1971 Eeport Pages =1
I Team Augnentation

Link to brokendown scheduls {(,Ilac:BnDw)
Link te Documentation f£ile (documentation,section=i, :xb)

7a

o

7d
78

da

10
1Qa
10b
10¢

10cl
10c2
10c3

l0clh

10d
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D8S (WSD) <(JCN)> Pages =10 104l
Journal 1l0dla
Journal Catalogs l0dlo
Ident Systen lodlc
Number System 10dld

‘Handbook (MFA) <JCN> i0d2
contents Pages =30 as appendix 10d2a
Description Pages=z 3 _ 10d20

BRS (JCN) <DVN>Pages= 5 10d3

Basic NLS(CHI) <JCN> 10dL
User Features (CHI)Pages =15 lOdué

Sort/Merge (JDH) 10dhal
Split Screens (CHI) 10dka2
Cross File Zditing (CHI) 1044a3
User Programs 1l0dhal
cutput Processor lodhab
Control File 10dhas
D Y I 10q4a7
TNLS (MFA . s FRALIREE 10dLa8
. 10dus9
. _ 10dLkalo
. s 10dkall
Languages b 10dkb

L10 Pages =5 10dLbl

Tree Mcta@?’ages =10 ’ &V—M 10dhb2
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MPS (WHP) 10dkc
Internal organizationrt 10d5
Team Structure(JCN) <DVN> <RWW> Pages =5 lodba
POD Activity(JDN,DVN) <JCN> Pages =2 10d5b
10d6

IT NIC Development and Qrerations (RWW) <JCN>Pages = 20
{documentation,section=-II,:xb) l0e
. 10el
" 10e?2
. l0e3

III Neuwork pParticioation (RWW) <JCN>Pages=10Q

(documentation,section-IIL,xb) 102
Working Group Participation 10£1
Systen Software lof2

IV Computer Faciliiy
Link to Documentation file (documentation,section-iii, :Xb)

Link to broxendown schedule (,IVsc:snDw) 10g
Haraware (JCuH) <DVN,EXV>Pagessl0 10gl
Summary Description 1l0zla
RPO=213 10glal
Terminals 10gla?2
PDP=10 10#rla3
Frinter 10glak
Display Systen 10glab
X=core 10glaé
Bryant Drunm 10gla?
UNIVAC Drums _ 10glad
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Notes on telephone call from Bill English of Xerox PARC:
4/13/72

l. MOUSE INTERVIEWS:

Truett Thatch will be at ARC 4/14 in the am to talk briefly
with six or seven ARC users of the mouse and keyset about
their reactions to the design of the present devices and to
some configurations Xerox is working on.

Truett did visit ARC 4/14, and performed the above
interviews,

He saw JCNy, HGL, MFA, JBN, and others.
2. CYBERNEX DISPLAYS

Xerox is ordering 32 display units from Cybernex to be
delivered about October 1972 to Xerox PARC

Bill's question 1Is: Does ARC want to order some of the new
displays too? Cybernex is interested in making some for us,
probably (?)

The terminals cost about $ 4,000 each. Also needed:
controller (s57)

ACTION:z

We should call Roger Bates at Cybernex to get further
discussion of the costs, configurations, and timing if we
are interested.

J. ADDITIONAL RPO2 DISKPACKS FOR ARC FROM XEROX

Xerox is offering to add one or two RPO2's to the ARC
equipment configuration to provide more filespace, mainly due
to the space needs that will be generated by the MPS project
being carried on cooperatively by ARC and Xerox on the PDP-10.

ACTIONZ=

ARC (delivery?) should figure costs and technical
requirements to add two more RP02's to the system as fast
as possible.

There are questions about how we would use the added
capacity e« does the MPS project get guaranteed use of the
extra packs? How can we do so? What other implications are
there about Xerox's share of the cost of the system used in
the development of MPS?

lal

la2

2a

2b

2c

2d

2d1

Jb

3bl

Jdb2
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*¥%% DRAFT *%*% Outline of the Operators' Objectives and

Responsibilities

The main ob,jective of the operators roles?! is to insure that
the computer facilities designed for both local and NET usage are
available as scheduled. This objective is accomplished by
continual monitoring of the state of the systemy and performance
of a number of daily duties; which are briefly outlined below.

The following areas are those which the operators are
responsible for as of the present date.

1. Maint, of local system

a. Act as first shot trouble shooter for various system
failures, attempting to coordinate activies of software and
hardware personnel

1. Bring system up from crash

a. Switch out of system any non—-working device

b. Check and repair (if neccessary) directory system

2. Run diagnostics during day or off-hours

be Collect statistics and format the UP-DOWN Chart

c. Set DBUGSW at its appropriate setting ( 1 or 2 during
dayy and 0 during off-hours)

2. Maint. of NET

as Periodically check status of NETSER,; esp. 5 am — 6 pm
{and take appropriate corrective measures when it fails)

l. Cycle NETSER if TELNET fails)

2. 1f Step 1 fails, notify any NET users, and cycle the
NET (NETON offy, then on)

Jd. If Step 2 failsy; notify appropriate personnel,; and
fix hardware and/or cycle the monitor

be Coordinate hardware efforts concerning IMP (i.e.
maintain contact with BBN)

Jd. Ride shotgun over flile system

a, Retrieve files from dump and {ARCHIVE> tapes.

Zal

2ala

2alal

2ala2

2alb

2al

2ad

2b

2p1

Z2bla
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2cl
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b. Archive files for users
c. Move files from one directory to another

d. Copy various files to DEC tape for shipment to other
software groups

e. Insure that there is sufficient disk space (and run
DELD if there is not)

f. Make first shot repalrs and adjustments (like disk
alloc. and passwords) to directory system

4, Journal System Maint.
a. Insure that the Journal is available for submission
from Sam until 6pm (by trying to submit a message), and
notify apropriate personnel if BACKGROUND is in SNKERR, or

submission test fails.

b. Run Journal Hardcopy Formatting job daily (and
coordinate appropriate personnel if this fails)

c. Coordinate printing of Journal Hardcopy
d. Help WSD fix Journal when it is not available
S. Insure that a system dump is made after every workday
a. Malntain sufficient number of blank tapes
be Coordinate on—call personnel
6. Maintain various documents of System

a. Update Monitor Listings whenever necessary (about once
every week to ten days, whenever a new Monitor iIs brought

up )
b, Malintain Dump Listings

c. Update PROCEDURES Manual whenever necessary (same time
as Monitor Listings)

7. Provide user help and aid with various probleas

a., More definition will be forthcoming

2c2

2cd

2c4

2cH

2ch

2d

24l

2d2
2d3

2d4

2el
2e
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Brief System Guide for the Baseline Programs

All executable code is contained in <NLS>BASELN. There are
constants and variables declared in CONST and DATA.

As of this writing there are no known bugs in the Baseline
programs. The only maintenance required is the addition and
deletion of initials (of people or groups that may appear as
workers and/or pushers of tasks) as people leave and join ARC.
The strings containing the initials are in CONST. Also the
arrays LWKINMNTH (last week in month) and LDAYINMNTH (last day in
month) only pertain to 1972 and 73.

All variables in DATA are commented. Most of the variables are
Baseline Parameters and are documented in the User Guide.

The programs in BASELN can be divided as follows:

Command Parsers (DNLS and TNLS)
The source code should be self-explanatory.

Execution of Commands
The source code should be self-explanatory.

Baseline Sequence Generator Programs
This program is exactly analogous to a User Sequence Generator
Program. The only differences are that it need not be
compiled by the user (it's already compiled in NLS) and it is
instituted by the Goto Baseline Institude Sequence generator
command rather than the Goto Program Institute program xxx as
Sequence generator command,
User sequence generator programs are fairly tricky to write so
I won't attempt to explain how this program does what it does,
but only what it does —— read the source code if you want to
find out how.
The program BSQG does three things:

It provides a sequence of strings and/or statements to
NLS's sequence generator.

This is easyy it merely uses NLS's sequence generator.

If PERPERS is ony it runs through the file <MSR>BASEDATA
once for each of the specified persons/ids.

PERPERS is one of the Baseline Parameters. When PERPERS

Ta

7b

Tc

7cl

Tecla

Tc2
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is ony then a view of BASEDATA is produced for each of

the id's in the PEOPLE parameter., BSQG is used to

append all these views into one continuous segquence.

Each id reguires a pass from the origin to the end of

BASEDATA. Tc2a

If FIXLEV is ony, then the statement levels of the things
returned to NLS's sequence generator may be changed. Tcd

FIXLEV is a Baseline Parameter. Tcda

If a sequence has levels missingy, e.g.y if SUBHED is

OFF,; there will be no level J statements, then Execute
Assimilate doesn't do what you would like., FIXLEV fixes

up the levels of the things returned so that there are

never any levels missing and everything comes out the

way you would like, Tc3b

Baseline Viewing Program 8

This is exactly analogous to a Content Analyzer/Reformatter

program with the same exceptions as noted for the sequence

generator program. It decides (on the basis of the current

settings of the Baseline Parameters) which statements of

BASEDATA are to be seen and in what format., Ba

I would suggest looking at the descriptions of the Baseline
Parameters in the User Guide to see what this program is
supposed to be doing. Sb

The only tricky part is in making up calendars (changing the
numerical/symbolic dates in BASEDATA to strings of X's or ?'s

or whatever) and getting the header and footer to line up with

the strings. There's a Lot of calculation to figure out how

many spaces to put where. ac

Basellne Checking Program 9

This is another Conan program, It thoroughly scans each

statement in BASEDATA, checking as much as it can of the

format and content, If anything wrong is found, a terse error
message and the offending statement pass the Conan program. 9a

I would suggest looking at the possible error messages (which
are documented elsewhere) to see what this program is supposed
to be doing. 9b
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SPEAKEASY is a system that provides scientists with easy
access to the power of a modern computer by providing a highly
modular library of routines that can be joined together Into an
operational program, The routines of the system resemble true
mathematical operators, A problem is programmed by bring
together the needed operators with a simple directive language.
The language is easily learned since its form is similar to that
of scientific mathematics,

SPEAKEASY was developed by the Argonne National
Laboratory to serve the field of nuclear shell—-model studies and
has since become a generalized program. It is presently
available on UCSB's J6075 thru their on—line— system. For
additional information on SPEAKEASY and its use contact me or
call SPEAKEASY's author Dr. Stan Cohen:

Physics Division
Argonne National Labs,
9700 South Cass Ave
Argonne, Ill.
Phone: 312-739-7711, ext 2857 or 2862
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Baseline Task Requirements as of 10 MAY 72 for: All

Branches: 1
NLS la
TENEX 1b
NIC lc
DSS 1d
Library'Catalogs le
MSR 1f
Documentation lg
Miscel laneous lh
NLS'Maintain 1i
Journal'Maintain 1j
TENEX'Maintain 1k
Ongoing'"Tasks 11
Needs'Possibilities 1m
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Baseline Task Requirements as of 10 MAY 72 fors: All
NLS 2
Primitive NLS Debugger >WSD JTM 2a
Requirements: 2al

A source level debugger with capabilities to examine stack, data,
fields of records, set break points and continue from them, etc.

. 2ala

Parser and core routines to implement this debugger in NLS.
2alb
OP FRS0 Stuff >BLP? 2b
Requirements: 2bl

Do stuff like different character sizes, switch to grid

coordinates, etc. 2bla
Device Command >CHI 2¢c
Requirements: 2cl

Provide an Execute Device command that would enble a user to switch

back and forth from DNLS and TNLS. 2cla
DEX II >HGL DCE CHI WLB 2d
Requirements: 2d1

Allow user to specify many commands before any of them are

executed. Would be primarily used from off—-line. 2dla
(Journal ;6936, ) 2dlb

Basic File System >JDH WHP 2e
Requirements: 2el

Write and debug the primitives functions for the new NLS file

system ( property lists). 2ela

File System Design >CH1I WLB JDH 2¢
Requirements: 211

1) Catalog file which allows 2fla
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Backlinks 2flal

Comments on both ends of linksy and independent comments archive
info — interface with BSYS archive system 2fla2

file comments 2flal
2) Allow NLS files to include portions of other NLS files 2flb
implements set system capabilities 2flbl

J) Design set definition language and set evaluation, etc. command

lLanguage 2flc
DNLS Address Options >CHI 2g
Requirements: 2g1

Make all TNLS statement address options available in DNLS. 2zla
NLS Verification Driver >CHI 2h
Requirements: 2hl

Some way of automatically executing all of the DNLS and TNLS
commands to see that they are there and that they work (to some

degree anyway ). 2hla
Smarter Fast Create Display >CHI DSK? 2i
Requirements: 2i1

Rewrite sections of display support routines in NLS to accomplish:

2ila
a) Selective updating for display areas representing files
affected by structural edits. 2ilal

b) Selective reformatting and display refreshing for statements

affected by structural editing. 2ila2
Dynamic User Program Buffer >WLB WHP 23
Requirements: 2.1

Make the size of the buffer which holds user programs dynamic.
Under user control, It will take space from the file pages.
See WHP and BLP for implementation informatione. 2jla
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NET Coupling to NLS >JDH? WSD? CHI? HGL JTM 2k
Requirements: 2k1
Entry to NLS from foreign text systems. 2kla
Mail delivery to ARC Printer. 2klb
Subtasks: 2k2
Sequential File 10 >CHI? 2k2a
Requirements: 2k2al

Make it possible to do an output sequential followed by
insert sequential (and vice versa) preserving initial
structure and content. Define format of sequential file so
that users of other editors can get their extant files into
NLS files ( hopefully with minimal effort on their part ——
maybe a set of optional formats; although this does not seem

desirable from out viewpoint). 2k2ala
Buyer(s): 2k2a2
NIC, SEAS 2k2ala
Costs: 2k2ad

2 man weeks. 2k2ada
Journal Delivery Optioans >JDH WSD? 2k2b
Requirements: 2k2b1

Fix up elegant means of determining whether documents should

delivered on— or off-line. 2k2bla
Online Remote Delivery >JDH WSD? 2x2c
Requirements: 2k2cl

Be able to deliver Journal items to online files at the

remote host of the addressee. 2k2cla
Sub—Contracts: 2k2c2
{ yNetwork?File'Transfer) 2k2c2a
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DEX Over Net >HGL JTM 2k2d
Requirements: 2k2dl

Allow input with DEX over net from punched tape, segquential

files from text editors such as TECQO, etc. 2k2dla
Jrnl Selective Dissement >WSD? JDH? 2kle
Requirements: 2k2el

Build a module to plug into the Jjournal distribution
mechanism that will selectively disseminate access copies to
author{(s), distribution, station collection(s) and
disseminate items based on some crude interest basis to other

sites. 2k2ela
Jrnl Remote Hardcpy Dlvr >JDH? WSD? 221
Requirements: 2Zk2f1

Use the Network Mailbox facility to deliver Journal items to

be printed at the remote site of the addressee. 2k2fla
Sub-Contracts: 2k2£2
(gNetwork®*File'"Transfer) 2k212a

NLS Execute Logout Command >DSK 21
Requirements: 2L1
Execute Logout command in NLS. 2lla
Journal Comment Command >WSD? JDH? CHI? CHI? 2m
Requirements: 2ml

A Journal Comment Command should be added to DNLS. Syntax "E'J'C('M™
BUG flag « true;/BUG flag « False) TEXT CA Zmla

Semantlics: submits the inputted texty, preceded by "comment on (LINK
to statement or message ): CR" as a Journal Message and distributes
it to the identlist which received the original message/file

2mlb
This could be expanded to allow bugging a structure as an
alternative to TEXT. If a message is being commented on, the
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Journal number is bugged, otherwise the statement is bugged and the
link (Journal, Journal number, statement number ) is created.

2mlc

The Initial text (up to a CR or to 72 chars will be used as a
Calculator >NLS 2n
Requirements: 2n1l

Reinstate the old Calculator, add graphics and ability to work on

tabular data. 2nla
Graphics >JDH? JTM? RWW 20
Requirements: 201

Make a graphics package. May be intimately related to the
calculator. 2ola

May Include ways to specify from typewriters drawings in TNLS
whichy when output through Output Processor, would create line

printer drawings. 2olb
File Property List Convert >JDH? 2p
Requirements: 2pl
A way to convert our present files to the new file way. 2pla
Property Lists in NLS >JDH? 2q
Regulirements: 2q1
Change NLS to use the new file system (property lists). 2gla

NLS Written for MPS >DWHP WLB? WSD? CHI HGL? JTM? JDH? JGM? LPD?
2r
Requirements: 2r1l
Redesigny rewrite NLS to use facilities of MPS. 2rla
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TENEX J
SUPERWATCH Extensions >DIA Ja
Requirements: Jal

A better WATCH program that displays statistics on screen. Jala
Evaluate RST File System >DCW KEV? RLD? Jb
Requirements: dbl

Evaluate RST's new file system and decide whether to implement.

dnla
Shared Page Manage Evaluate >DIA BBN Jec
Requirements: Jel

TENEX didn'"t handle core management of shared pages very well. Don
devised a better scheme. BBN modified that scheme. Don will look
at BBN's scheme and see if will suit our purposes well enoughe.

Jcla
Crunch Working Set JSYS >DIA BBN Jd
Requirements: Jd1

Implement a JSYS to crunch your working set whenever a job feels it

won"t use the pages now in it. Jdla
System Effilcliency Study >DIA MDK Je
Requirements: Jel

Study measurements and plan system changes to increase efficiency

and capacity of system. Jela
Increase Capacity Plan >DIA RWW CHI MDK ar
Regquirements: 311

Develop plan for increasing capaclty — conslidering things like

more core, disk packs, etc. Jfla
Literal Collection by Monitor >CHI DIA dg
Requirements: Jdgl
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Have the monitor do lLiteral collection and feedback without
awakening the job ({ like a fancy immediate echo) with wakeup
conditional on receiving one of a set of break characters or on

recieving a certain number of characters. Jdgla
Sequential Display Area >CHI WSD Jh
Requirements: dhl

Change Allocate Display Area JSYS to also allow allocation of a
"Sequential" display area. A Sequential Display area is a
generalization of tty simulation. Also change tty routines for tty
simulation to use a seq. da. Add a JSYS to make a seg. da & copy

of tty simulation. Jhla
NET Measure >DIA JTM? Ji
Requirements: Jdil

Some measurement hooks needed to see what extra overhead is

involved with Network users as opposed to local users. Jila
Subroutine File Study >CHI DCW? JTM KEV dJ
Requirements: 34l

Feasibility study into possibility of implementing a simple
subroutine—file mechanism Iin the file system, disregarding
file—related capabilities which do not make sense for subroutine
files. Sub—files would facilitate use of other subsystems (like
telcom, Macro, Fail, etc) from NLS. Note: this also includes

subsystems running on other Network Hosts. Jjla

B5YS >DCW KEV? RLD? % }'3
Requirements: Jkl
More things for the Backup SYStem. Jkla
Subtasks: Jk2
Full Dump Restore >DCW KEV? Jkx2a
Requirements: JkZal

Full dump/restore function. Jklala

10
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Complete checkout of full dump/restore. JkZalal
Single Dump Restore >DCW KEV? Jk2b
Study Core Size >DIA at
Requirements: Ji1

Ve need some idea whether or not we are operating at any point in
time at a bad point with respect to total core. We cannot simulate
the effect of additional core, but we can try to determine if we
are at a point sensitive to core size by running a load of standard
users as described above against a system in which we can gradually
logically remove pages of memory and then measure response and

other parameters, Jlla
User Disk Overlap JSYS >KEV DCW RLD? Jm
Requlirements: Jmi

Write new JSYS so we can overlap disk operations with processing in

user mode. dmla
Network File Transfer >JTM an
Requirements: Jnl

Be able to transfer files to and from other sites on the Network.

3nla
Net Error Handling >DCW KEV? RLD? Jo
Requirements: Jol

More and better error checking and recovery from errors in the Net

stuff. Jola
Bug Selection In Monitor PCHI? Jdp
Requirements: Jpl

Have the monitor do bug selection without awakening the job (like a

fancy immediate echo). dpla
Improve Xcore Diagnostic >DCW KEV? RLD? Jdq
Requirements: Jql

11
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Improvements to the present Xcore diagnostic.
IMP Interface Diagnostic >EKV JTM?

Requirements:

Write a diagnostic for our IMP interface hardware.

12
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NIC 4
Catalog Card System >RWW JBN DRC 4a
Requirements: 4al

Design a means for producing cards for the NIC documents, cards to

be sent to stations,. 4ala
Auto Transmittal Letter >JBN RWW 4b
Requirements: 4b1l

Automatically generate weekly transmittal letter as a product of

the Nic Catalog input. 4bla
Data Management Needs >RWW 4c
Requirements: 4cl

Deciding what the data management needs of NIC are and seeing about

haveing them satisfied. 4cla

New Improved Netstat Command >JTM 4d
Requirements: 4d1l
Design a new Network Status Command. d4dla

Karp Categories >J BN 4e
Requirements: 4el

Establish Karp categories for NIC documents, where not already
established, code them, and enter information into catalog.

4ela

NIC Operations Coordinator >RWW JCN DCE 4rf
Requirements: 411

A person to coordinate NIC operations. 4fla

13
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DSS S
Flexdoc >WSD S5a
Requirements: Sal

A system to aild in the manipulation, protection, and coordination

of documents in the formative state. Sala

See (Journal, 8137,1, ). Salb

Net Access Copy Processor >WSD? JDH? Sb
Requirements: Sbl

This processor will take an access copy from the Journal and make
copies for author(s) and receiver(s) station collections and for
documents to groups it will send an access copy to those access
collections of sites desiring to be on distribution for that group.

Sbla
Identification System Stage I1 >WSD Sc
Regquirements: S5cl

The Identification System enables keeping information about all the
people known to it — like name, initials, account number, address.

Scla

DSS Design >WSD 5d
Requirements: 5dl
Think and write about long term DSS stuff. Sdla

14
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Library'Catalogs 6
Catalog Project Plan >BAH DVN Ga
Requirements: 6al

To make a project plan for updating the NIC Catalog in the future.
The plan will be based on the procedures in my file, Recipe,y, and

the flow chart Beau drew to go with it. It will include a detailed
schedule, fine definitions of what each worker is doing; meetings,

and provision for changing the plan as it goes along. bala
Winter 72 NIC Catalog >DVN RWW JBN BER WLB CP MEJ BAH LLL 6b
Requirements: 6ihl

A new set of catalogues of the NIC collections similar in form to

the present catalogue including many new entries. 6bla
Catalog System >WLB RWW WHP HGL be
Requirements: el
Design the Master Catalog System. 6cla
Backlog NIC Docs Ident >JBN RWW MEJ b6d
Requirements: 6di
Identify NIC documents among site docs held by ARC. 6dla

L5
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 ;
Develop RADC ARC Baseline >JCN PXR Ta
Requirements: Tal
RADC wants to do some Baseline kinds of things. TJala
Resource Accounting Design >JCN EKV RWW DCW b
Requirements: b1l
Develop system for keeping track of how are our various resovurces
are used. These include people time and productivity, computer
gsystem power, materials, dollars. Tbla
Requirements from NIC: Tblb
Catalog input Tblbl
Duplication Tblb2
Phone Tblbl
Mailing Tblb4
Training Tblb5
System development Tblbb
Computer operations Tblb7
BRS Design >BLP JCN Te
Requirements: el
Ongoing design work and thinking about BRS. Tcla
Roles Development >JCN DCE RWW EKVY CHI Td
Requirements: Tdl

Developing the internal organization of ARC and defining what kinds
of roles there are to play. The idea is to design an organization
and then implement it, considering the whole thing as an
experiment. Tdla

16
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Documentation B8
Super Watch Doc >DIA Ba
Requirements: Sal
Document the new Super Watch program. Sala
Document SRI JCIES >RLD DIA KEV CHI WSD 8b
Requirements: 3bl

Collect and/or create for JSYS Manual documentation of JCIES

written at SRI. Sbla

New TNLS Command Summary >MFA Sc
Requirements: scl

A summary of new TNLS Commands. Bcla
Revise TNLS Ref Manual >MFA s5d
Requirements: Bdl

1) Fill out to make complete
2) Clean up glitches and other problems found in fTirst release.

S8dla

DNLS User Guide >MFA Se
Requirements: Bel

A full-blown users' guide for NLS on TENEX. SB8ela

TNLS Primer >MFA 81
Requirements: 8f1

Write a primer of basic TNLS functions suitable for introducing a

typist to TNLS. B8fla
Baseline System Document >BLP Sg
Requirements: Szl
Vrite system documentation about the Baseline software. Bzla

LT
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OP System Document >BLP WLB? 8h
Requirements: Shi
Vrite system documentation about the COutput Processor. Shla
TNLS User Workbooks Wave 2 >DVN Bi
Requirements: il

Workbook kinds of things for teaching TNLS users. Intended for NIC

Station Agents and others. S8ila
Visitor Log System >JCN MFA 8.
Requirements: 8J1

Visitor log system design and implementation
See (961J,y) for proposed designe.

The procedures need documenting and put into use. S8jla

RADC Final Report 8457 >DVN JCN MFA CHL WHP RWW WLB HGL WSD DCE
DCW KEV BLP JBN 8k
Requirements: Bkl
Final Report for project 8457 ( RADC/ARPA) 8kla

Needs a plany contributor assignments,; sections written,
integrated, edited; approved, reproduced. DVN is suggested for
pusher to see that it falls together. Bklal

Draft is due at RADC 6-8-72 in cleany ready to print (unless

changed) form. Bkla2
TENEX System Guide Write >DIA JTM DCW 8L
Requirements: 8L1

Along with other measures of the TENEX Users'" Group, develop

documentation for TENEX. 8lla
Subtasks: 812
TENEX Scheduler Document >DIA Bl2a
Requirements: 8l2al

18
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An explanation
NCP Document
Requirements:
An explanation
Telnet Document
Requirements:
An explanation
TENEX File System Doc
Requirements:

Documentaion of

TENEX Memory Manage Doc

Requirements:
Another section
NLS Documentation
Requirements:

1) overview of NLS —-—

ESRI-ARC.JCN 20—-APR-T72

of 10 MAY 72 for: ALL

of how the scheduler works.

>JTMN
of how the NCP works.

>JTM

of how Telnet works.

>bCw

the TENEX file system.

>DIA

of the TENEX documentationa.

>CHI WHP

7

145 10124

SlL2ala

812b

8l2bl

Sll2bla

dlic

8l2cl

8l2cla

Bl2d

8L2d1

dl2dla

Blle

Bl2el

Bl2ela

Sm

Bml

how functional areas and procedures interact.

2) description of levels of NLS

Smla
Smlb

3) standard format for procedure doc and make sure it is there.

Processes to extract
Document Sort Keys

Requirements:

this.

>DVN

Smlc

Bn

Enl

There are a number of L10 sort key making programs around in
different people's directories useful for different purposes and
valuable to many people if documented and available.

Dump Procedure Doc

>WRF

19
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Requirements: Bol
Writeup full dump procedure., Sola

20
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Miscellaneous 8
Tasker Upgrade >EKV 9a
Requirements: Jal

Our display system needs improvement, Perhaps by tweaking and
tuning and modifying our present equipment or perhaps even by

getting a new display system. Yala
Hardware Documentation >EKV BAH 9b
Requirements: 9bl

Bring documentation on all our hardware up to date and make it
complete, MEH and BAH will do documentation that serves hardware
trouble—shooters.s will do documentation that serves programmers.

9bla
Control Environment >CHI DIA Sc
Requirements: 9cl

Set up so that the system can be run repeatedly under the same

{controlled) load — a benchmark — so that good measurements can be
takena. 9cla
Hierarchy Orientation >DVN RWW JBN Sd
Requirements: 9dl

Through discussion and teaching aids to establish rough default
notions of how the hierarchy of NLS should be used in entering

text. 9dla

PSST Procedure Development >JBN DRC HGL WLB BAH LLL BER MEJ DVN
MFA Je
Requirementss: el
Develop plans (and implement them) for PSST procedures — hiring,
training, modes of operation. Bela
Video Tape Equip Study >HGL MEH??7? gt
Requirements: 9f1

Find relevant data on video tape recorder, camera system,

21
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summarize, and present to operations and New Development people for
consideration., We should aim toward a setup that will: 9fla

—— allow both screen recording of text and "environmental®
(people, things) views. Two cameras? for later mixing to

produce one integrated tape for use in demos, etc. 9flal

—— be compatible with a projection TV under consideration (as

another baseline task). —— JCN 9fla2
ONR Annual Report 8622 >DCE JCN JBN??7? 9g
Requirements: 9l

Annual Report for preoject 8622 (ONR).
This needs writing and publishing (5-10 pages ).

Due S5-15-72. Jdgla
Projection TV >EKV MEH JCN? 9h
Requirementss: gnl

le Produce specifications for a workable Projection TV system that
will: 9nla

—= be used in ARC conference room. 6'x8"'" screen? larger?

9nlal
—— be operated by users, not projection "experts", 9nhla2
—= be compatible with our displayse. 9hlad
-= have good resolution, stable projection. 9hla4d

—= other features to be sought out from CHIy, DCEy JCN, DVN, and
others. 9nlasd

2. Find potential suppliers of equipment that meets reguirements.

Costs, delivery times needed. 9hlb
Demonstration Training >JCN DVN MFA 277 9i
Requirements: 9i1l
ARC Demonstrations —— Training of ARC people, organizing of See
(9615, ) fro draft of this task need, regquirements, plan. 9ila

RADC Equip order >JCN MEH EKV 94

22
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Requirements: 941

Order IMLAC's and termicettes for RADC as per proposal 1SU72-438

See (9248,) for details. H9jla
Followup until approved, ordered, and delivered. 9jl1lb
Operations Development >EKV JCN DCW MDK 9k
Requirements: 9k1

Developing procedures and practices for providing service. 9kla
MPS Development >WHP JGM LPD HGL a1
Requirements: 911

Allow programmers to easily modify and debug large systems of
programs by providing facilities for adding and replacing modules

of the system and source language level debugging. 9l1la
Small Machine Study >CH1 WHP Im
Requirements: Oml

Feasability study of use of small machine(s) to act as buffers
between users and TENEX. The program running in this (these) small
machine(s) would be the interactive segment of NLS (i.e.y; the users
would interact with this program to specify a command), and the
program running on the TEN would be the non—interactive file
manipulation segment of NLS. Omla

We would probably want a simple operating system for the small

machine(s)y; with no swapping and no file system. 9mlal

User Program Techniques >WLB BAH DVN MFA? 9n
Requlrements: 9nl
Helping Beau learn how to programe. 9nla

MPL Written in MPL P>WHP LPD JGM 9o
Requirementss: Yol

Make MPL self-compiling by adding Tree Meta like facilities and
rewrlting compiler. So0la

23
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Recruiting >JCN CHI DCE RWW EKV 7?7?77 9p
Requirements: 9pl

1 new hardware engineer —— EKV/JCN 9pla

1 documentations specialist —— for RADC/ARC work —— JCN 9plb

1 research analyst/programmer -— for RADC/PSO work —— JCN 9plc

4? several senior professionals —-— DCE 9pld

2 System Programmers (4?) —— CHI 9ple

24
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NLS"Maintain L0
Rerun NLS Xref >WSD 10a
Requirements: 10al

The "catalog" or cross—reference of subroutines is badly out of

date. _ l0ala
NLS Clean Up >CHI DSK NLS 10b
Reguirements: 10b1

There are a number of things that should be done: Clearly define
the boundaries between core routines, x routines,; and user
interaction (control) routines, delete most globals, break things
into subroutines differently, break routines into files
differently, rewrite IOEXEC, "prettify” the source code files,

etc.y etc.y etc. i0Obla
Subtasks: 10b2
Finish Help >NLS 10n2a

Requirements: 10b2al

The Help command is incomplete and sometimes erroneous. MF A

has a list of some of its short comings. 10b2ala
Jump Cntnt etc Cmnd Spec >NLS L0b2b
Requirements: 10bl2b1

Eliminate need to type 'a after Jump to Name, Jump to

Contenty, Jump to Word, etc. — perhaps by letting one bug

name register. 10b2bla

Jump Feedback Stuff >NLS 10b2c
Requirements: 10b2cl

After a Jump to Return is completed, the up arrow in the
command lnput line doesn't return —— KEV. 10b2cla

In the first place;, Jump Return and Ahead don"t show an arrow
under the CRL like every other NLS command — BLP 10b2clb

25
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The bug mark should disappear (or change from an @2 to an *)
after the final CA in both Jump Link and Jump File Return —-

KEV 10b2clc
Conan Glitch >NLS 10¢
Requirements: 10ec1

When you have a content analyzer in force and type in a new pattern
as Lity, the system rejects it with a message like "no compiler
input" unless it fits the pattern In force. That doesn't make
sense because the new pattern is not part of the file. Should be

fixed only if it's easy. — DVN 10cla
Debug Substitute Plex >NLS 10da
Requirements: 10d1

When you substitute an item which occurs in a few statements in a
large file by substitute plexy, it fails to make some of the
substitutions. The feedback tells you the number of substitutions
you actually made (i.e.y a number lower than the actual occurrence

of the stringls. — DVN 10dla
Create Display Problems >CH1 DSK NLS 10e
10el

Requirements:

A collection point for all bugs and glitches having to do with

create display, bug selection, etc. 10ela
Subtasks: 10e2
CD Tabs and Tabstops >DSK CHI? NLS 10e2a
Requlrements: 10elal

If there are n regular characters Iin a statement and then a
tab and there is a tabstop set to the ntlst column, then the
tab character ought to be displayed in the ntlst column and
the next character In the n*2nd column. 10e2ala

Currentsly the first tab (column 8) can indeed occupy the Sth
column and there can be a character in the 7th column.
However any subsequent tabs cannot have a character in the

column immediately preceeding the column of the tabstop.
10e2alb
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CD Gym Bug >DSK CHI? NLS 10e2b
Requirements: 10e2bl
Where G — (statement #s on rt)
¥ — (blank lines)
m — ( statement #s on) l0e2bla
Viewspecs are ony, create display messes up — extra characters
appear and bug selections are bad. Several horrible editing
errors occurred because of this —— HGL. Ll0e2blb
CR Bug Mark Glitch >DSK CHI1? NLS 10e2c
Requirements: 10e2cl

When a statement ends with an EOL and the cursor is placed in
the (blank) line below the EOL, a bug selection puts the bug
mark in the blank line and gives the message, "illegal string

designator" — BLP. l0elcla
CD State Nums Right Bug >DSK CHI? NLS 10e2d
Requirements: 10e2dl

When statement numbers are to be displayed on the right and
there is an EOL in the first line of the statement or blank
lines are ony Create Display fucks up : extra characters

appear and bug se lections are bad — BLP HGL. l0e2dla
CD Large Char Tab Bug >DSK CHI? NLS 10ele
Requirements: lDelel

If character size is set to 2 and there are tabs in a
statement; Create Display does not break lines the right way'
the tail end of the line is displayed in the left margin ——

BLP 10eZela

Tab Bug Selection Glitch >DSK CHI? NLS 10e2¢
Requirements: 10e2f1l

If there is more than one tab in a line l0e2fla

the cursor is in the blank space after any tab but the
first or the cursor is beyond the right end of the line
10e2flal
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and a bug selection is attempted: 10e2fla2

the bug mark is shown in the column after the tab or the last
character in the Lline L0e2flb

the character selected is the character after the tab or EOL
or the character after the end of the statement {an error

message results in the latter case) — BLP, 10e2flc
Frozen Bug Mark Glitch >DSK CHI? NLS 10e2g
Requirements: 10e2g1

When bug selecting a frozen statement, the bug mark is not

always displayed —— BLPe. 10e2gla
File Alloc Exceed Glitches >NLS 10¢
Requirements: 10£1

Vhen a user exceeds his file space allocation:
NLS often crashes with a PUSHDOWN STACK OVERFLOW after an Execute
Quit; the new file is sometimes left open, meaning you can't update

to it any more, etc. — BLP. 10fla
BSTLIT CR Glitch >NLS 10g
Regquirements: 10g1

When do an Insert Character and the character is a carriage return,
the top line of the display does not get restored on completion of

the command — BLP. 10gla
Change @ in Statement Numbers >NLS 10n
Requirements: i0nit

Should be able to address a statement number directly which
contains an alphabetic zero (i.e., statement number 1B@) without
the system bombing out to your NLS file. At present must approach
such a statement indirectly through ! or LINE FEED. Cannot now do
any work or editing on a statement with that kind of number.
Striking the @ key on the Tl terminal, regardless of where pointer
is sitting, throws you out to your NLS file. — MEJ l10hia

Generalize Substitute >NLS 10i
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Requirements: 10i1
Allow Substitute (Text/Vord/Visibleas.a). 10ila
Marker Bugs and Glitches >NLS 10
Requirements: 1041

Something is freaky with Execute Marker List Show. [ suspect it
will list only markers that were created in this partial copy ——
although the older ones will function as addresses. 10jla

While we're about it, they might stay on the screen longer—-—DVN.
104jlb
Output file destroys markers, 10j1e

Execute marker lists show goes by much too fast —— it should stay

until turned off by a CA. 10jld
Modify Open File Glitch >NLS 10k
Requirements: 10k1

It is currently possible that two persons (or a person and the
Journal) could both modify the same version of the same file and
one of the sets of modifications would be lost. If a file is open,
but not Llocked, another person (or process) could open it, modify
ity and update it., Subsequently the person who had it open in the
first place could do the same thinge. 10kla

The following solution is proposed: 10klb

Whena PC is about to be created (first edit), check if there
exists a higher version of the file, If s0o, issue a warning
message. If an Output File is requested, there is no PC, and
there exists a higher version of the file, issue a warning

message — WSD BLP. 10klibl
Recovery from Bad File >NLS 101
Requirements: 10L1

NLS must be able to go on after "bad file". Should be able to load
another file — WHP. 10lL1a

Jump File Return To Char Pos >NLS 10m
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Requirements: 10ml
In TNLS Jump File Return should restore the character position

pointer as well as just getting you back to the previous statement
~= DIAe 10mla

30



ESRI-ARC JCN 20-APR-72 7:45 10124

Baseline Task Requirements as of 10 MAY 72 for: AlL
Journal®Maintain 11
Journal Reenter Capability >JDH WSD? lla
Requirements: llal

Allow the user to reenter the "submit" subcommand, preserving the
parameters from the preceeding "submit", Useful in case user bombs

out due to Journal systems errors. ilala
Journal Speedup Phase 11 >JDH WSD I1b
Regquirements: 1lbl
Speed up the Journal., libla
JNLDEL Problem >NLS l1lc
Requirements: . ilcl

Solve the problem of people doing a Jump File Return to get to
their initial file while in the meantime Journal Online Delivery
has updated the file. llcla

One suggested way: lliclb

Have JNLDEL set a bit in the FDB whenever it updates an initial
file. liclibl

Jump File Return would then check that bit and if on,; would
display a warning message; €.g.y "Journal has updated this file.

There is a higher version." 1lclb2
Journal Number Bug >WSD JDH 11a
Requirements: 11d1

When submitting a message to the Journaly if you hit the wrong
character when asked for "Number:i", you get bombed out and lose all
the effort you put into composing the message. Instead of getting
bombed out of the Journal systemy; you should eithers: llidla

(1) Be asked repeatedly for "Number" until you give a correct
response or lidlal

{(2) Be given a chance to enter the number using a "Number”
command ("Go won't work until you have). ildla2
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I think that (1) is probably preferable —— WLB. Lldlb
Preassign Number Glitch >WSD JDH? lle
Requirements: l1lel

tA ( backspace character) doesn't work, apparently, to correct an
incorrectly typed preassigned number — BER. llela
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TENEX'Maintain 12
Disk Diagnostic Changes >DCW KEV? RLD? 12a
Requirements: 12al
A bunch of things to do to improve the disk diagnostice. 12ala
Subtasks: 12a2
Rdisk User Mode >DCW KEV? 12a2a
Requirements: 12alal

Make rdisk so if runs in user mode with restricted write

capability. 12a2ala
User Interface >DCW KEV? 12a2b
Requirements: 12a2bl

Redo so0o runnable by hardware troops without infinite

knowledge of DDT —— primarily default to do the "right" thing
and play gquestion and answer game where practical.
12al2bla
GTJFN Free Storage Bug >DCW EKEV? RLD? 12b
Requirements: 12b1
gt ijfn problem (Duvall) suspected free storage bug. i2bla
JSHB String Storage Bug >DCW KEV? RLD? 12¢
Requirements: 12cl

This is the bugg that screws up Journal Hardcopy Distribution.

l2cla
Directory Smasher >DCW KEV? RLD? 12d
Requirements: 12d1

Directory smasher (believed related to Dumper Loop Bug). 12dla
Cleanup Network Code >DCW KEV? RLD? 12e

Reguirements: lL2el
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Recode 24—36-24 bit word transformation. 12ela
Network crash/recovery 12elb
no bughlt?s in network code 12elbl

possible write Y"crash copy" and restart for net stuff 12elbl

bughlt/bugchk analog for net 12elbd

Refuse connection should be more informative. 12elc

In Out Assembler File Spec >DCW KEV? RLD? JTM 12¢
Requlirements: 12f1

A specification for what Input Sequential and Output Assembler

File commands ought to doe 12f1a
On Line Disk Diagnostics >DCW KEV? RLD? 12g
Requirements: 12g1

Make diagnostics that will run on—line (when the disk is not being

used as a file storage device). 12g1a

User Change Password >DCW KEV? RLD? 12h
Requirements: 12hl
Allow a user to change his own TENEX password. 12hla
Loader Glitch >JTM DCW KEV? RLD? 12i
Requirements: 12i1

Fix the Lloader so it does the right thing with the symbols when

loading in the high segment. 12ila

TENEX Users Group >DCW KEV? RLD? DIA JTM? 12
Requirements: 12j1
Participation in the TENEX Users' Groupe. 12jla

Bugck and Bughlt Watch >DCW KEV? RLD? 12k
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Requirements: 12kl

Keeping an eye on bugcks and bughlts in order to spot troublesome
areass. 12kla
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Ongoing'Tasks 13
Journal Catalog >JCN BAH WSD 13a
Requirements: 13al
Print and reproduce current Journal catalog/indices. ldala

Continue to update author and titleword monthly with weekly number

index update including new entries. 13alb

Enter catalogs/indices into Journal as produced. ldalc

File hardcopy with access and DCE sets. 1Jald

NIC Evolution Plan >RWW 13b
Requirements: 1dbl

Develop a plan for NIC's evolution and relationship to ARC and BC,

its scope and mission. 13bla

NET Operations >RWW JBN MFA DVN JTM BER JCP CP CBH EKV MEH MEJ
13dc
Subtasks: ldcl
Folklore Maintenance Pub >MFA DVN? L3cla
Requirements: 13clal

Folklore is extracted from <NLS>STATUS periodically to
contain information for Network people not in the User Guide.

. l3clala

NIC Repro and Distrib >JBN CP BER JCP ldelb
Requirements: liclbl
Replaces reproduce Send NIC Docs moving to NET Operations.
l3clbla

Help to Net SA s >JBN ldcle
Regqulirements: ldelcel
Rewording of task: Station Agent Help lidclcla

Help For Net Users >MFA lidcld
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Requirements:

Answering the phone that NET users
about NLS, TENEX, etc.

NIC Station Agent Ops >JBN CP
Requirements:

Continuing work of the NIC Station Agent.
NET ID Entry >JTM BER

Requirements:

Getting new NET users'" identification information
system so they can log into us.
NET Site Training 2>DVN RWW
Requirements:
On~going site traininge.
NIC Resource Locator >DVN

Requlrementss:

Keep the NIC Resource Locator up—to—date.
Station Agent Help >JBN
Requirements:

Station Agent Manual

Site visits

Suggestions on storage circulation

NIC Supply Inventory >JBN CP BER CBH

Requirements:

Ongoing operations for the ARPA Network.

>MFA HGL
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13cldl

call to ask gquestions

13cldla
ldcle
lidclel
l3clela
l3cirft
13clztl

into the
13clfla

13clyg
ldclgl
ldclgla
13clh
13clhl
13clhla
13cli
13clil
13clila
13clilb
l3clilc
13clj
13c2
licla

13d
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Requirements: 13d1

Train first PSST clerical staff in use of DEX-1 using DEX-1 manual.

13dla

Library Catalogs Operations >JBN RWW MEJ BER CP LLL WLB PML
1Je

Subtasks: 13del
Cat Production Programs >WLB ldela
Requirements: 13elal

Maintenance of programs that produce catalogs, indices, and

directories. Lidelala
Code Abstract NIC Docs >JBN BER ldelb
Requirements: 13elbl

Code, abstract, check coding, and proof new NIC documents.

Ldelbla
Code Abstrct Record RINS >JBN MEJ BER l3delc
Requirements: ldelcl

Non—=NIC documents, including those presently held and new
receliptsy, must be processed for the catalog and files.

13elcla
Enter NIC Docs >JBN BER PML l3deld
Regquirements?2 ldeldl

Online and/or DEX entry and correction of of catalog entries

for NIC documents. l3deldla
Identify NIC Docs >RWW JBN 1dele
Requirements: 13elel

Search out references to documents desirable for NIC.

ldelela
Monitor Functional Docs >JBN CP 1delrs
Requirements: lJdelfl

Functional documents should be kept current by examination of
their content and NIC—initiated changes in them. 1delfla
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Obtain NIC Docs >JBN BER LLL l3delg
Requirements: 13elzl

Obtain ARPA reports and Karp biblio documents for collection.

ldelgla

Buyer(s): ldelg2
NIC 1delz2a
Obtain RINS Documents >JBN LLL 13elh
Requirements: ldelnhl

Obtain books, journals and documents for collection.

ldelhla

Buyer(s): 13elh2
NIC 13elhla
Weekly RINS Doc List >JBN BER 13eli
Requirementss: 13elil
ARC persons need of list of what's received. 13elila
Upgrade Master Catalog >JBN MEJ 1delj
Requirements: ’ 13deljl

To make corrections to citations in the Master Catalog, to
conform with present data element conventions,; making
possible the production of full, accurate catalog listings.

13eljla

Reguirements: 13e2
Updating catalogs and collections, etc, 1Jdela
Statistics Gathering >DIA 13f
Requirements: 13f1

To support the above, we need adegquate statistics gathering:
L3fla

(a) Of user characteristics, such as NLS command usage
fregquencyy; time between various operations such as command
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specification and sub—-command operation command inputy bug
selection,y, typing rate, etc. 13flal

{b) We also need to be able to define response time for our
system and begin taking measurement of this. 13fla2

{c) Of memory utilization. 13flad
{(d) Possibly a better graphics "Watch"—type program to run
online when the system seems slow or otherwise to see what is

going on. 13f1a4

{e) Statistics on system overhead associated with running the

Net need to be gathered. 1dflas

Output Processor Maintain >WLB BLP 13g
Requirements: 13g1
Bug fixing, cleaning up, speeding up programsa. L3zla
Identification System Maintain >WSD JDH 13h
Requirements: 13n1l
Bug fixing,; cleaning upy, speeding up programs. Ldhla

DEX Maintain >HGL 13i
Requirements: 13i1
Bug fixingy, cleaning upy Speeding up programs. l3ila
NIC—-WORK Directory Control >DVN WRF BAH 134
Regquirements: 131

Keep down the number of files and pages in NIC's directory.

User Documentation Maintain >MFA JCN CP BER PML 13:;:
Requirements: 13kl
See (77034). 13kla

TENEX System Guide Maintain >DIA 131
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Requirements: 1311
Keeping the TENEX System Guide up to date. lilla
Basedata Maintenance >BLP BER 13m
Requirements: 13ml

Keeping the planning information ( MSR, BaseDatay ) up to date.

Management And Coordination >DCE CHI EKV JCN EWW 1JT32
Requirements: 1dnl
Management and coordinating roles. 13nla
Accounting >JCN 130
Requirements: 1301

Keeping track of money, peoples? time, computer time, supplies

used., 13o0la
Facility Operation >EKV MEJ DCW JCP KEV? RLD? 13p
Requirements: 13pl
Whatever it takes to keep things goinge. 13pla
Hardware Maintenance >EKV MEH JR 13q
Subtasks: 13qg1l
Disk Reliability >EKYV 13qla

Requi rements: lidglal

The disk sure causes a Lot of problems. liglala

Mouse Button Bug >EKV 13ql1b
Regquirements: 13glbl

The left mouse button at one of the consoles sends multiple
characters when held down. Ldglbla

Requirements: 13q2
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Trouble—shootingy, tweaking, and preventive hardware maintenance.

13q2a
Percolation >EKV CP DCW JcCp 13r
Requirements: 14r1

Scheduling hardware use, doing dumps, handling tape Library,

getting supplies, etc. 13rla
Schedule Service 13r1b
Keep standard schedule updated 13ribl
Negotiate schedule changes 13rlb2
Receive all schedule change requests 13r1lb2a

Check verbally before making last minute changes 1Jdrlb2b

Negotiate PM scheduling with C.E."'s and our own hardware
people. 13rlb2c

Negotiate Hardware & Software modification scheduling where
the system is taken down or jeopardized and schedule special

dumps if needed. Ldribld
Communicate Schedule Information 13rl1bd
Keep schedule board updated 13rlbda
Keep Answering Service updated 13rlbdb
Monitor answering service 13r1bic

Inform Operations Software and/or Hardware personnel when
they are going to be needed off hours and determine that need
where possible. L3rl1bdd

Check ahead on irregular of flaky activities (i.e.y PM's, Dumps,

etc. ) where appropriate 13r1b4
Hardware Service 13rlc
Procurement ldrlci

See that requests for consoles, terminals, acoustic couplers,
etc.,y are satisfied. l3rlcla
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"Help" with TTY patch panel, console patch panel, etc.
13rlclb
Trouble 13rlc2

Be responsible for the necessary communication related to

trouble calls (We will get some bells and switches to help in

this area soon) 13rlc2a
Notify user that he has been heard instantly. 13riclal
Give user a practical answer (i.e.y down until ??, get
another consoley, you will be tuned shortly, ['m looking

for MEH so walt a minute) 13rlc2a2

Communicate the problem to the right people and get an
answer 13ric2ad

Monitor and follow—up all trouble situations. Don'"t Lleave
people or troubles in a neglected state. 13ric2a4

Operating Instruction 13rlcd

Show people how to operate TV set controls, patch panels,

printer; etc. on request, 1dric3a
Software Service 13rld
How—it—works help 13rldl

Provide for instant you-have—been—heard response. 13drldla

Find an answer or an answerer as soon as practicala.

13ridlb

Provide follow—up. 13ridlc
Trouble 13rld2
Software Bug Management 13rld2a

(I [EKV] don't know anything about managing this yet)

ldrld2al
Crashes 13rld2b
Keep users informed of status 13rld2bl

Respond instantaneocously with standard procedure
13rldib2

43



ESRI-ARC.JCN 20—-APR-72 7:45 10124

Baseline Task Requirements as of L0 MAY 72 for: AlLL
Record the wreckage parameters 13r ld2bla
Perform start—up operation. L3rld2b2b
Get help where needed, 13r1d2b2c
Information Service 13rle
Mag tape manipulation 13rlel
Punched Paper Tape Processing 1drle2
Disc Dumping or other back—up system activity ‘ 1lirled
Visitors >JCN ALL 13s
Requirements: 13s1
Taking care of visitors. 13s1la
Vacat ions >ALL 13t
Subtasks: 13¢t1
WHP Vacation >WHP 13tla
CHI Vacation >CHI 13t1b
Requirements: 132

Place for keeping track of when people will be away on vacations.
13t 2a
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Needs'Possibilities 14
NLS NP >BLP NLS WSD JDH WHP HGL KEV JTM WLB CHI DIA l4a
Subtasks: l4al
DNLS Linking >NLS ldala
Requirements: l4alal

The ability to link displays and imlacs when in DNLS so that

two (or more) users see the same view. —— KEV i4alala
Speedy OP >WLB BLP? 14alb
Requirements: l4albl

Perform measurements on the Output Processor and then rewrite

the important parts for speed, l4albla
Dangerous Cmd Spec Chng >NLS l4alc
Requirements: ldalcl

Protected commands, requiring two CA's to execute:
Unfortunately, being the impulsive persons we (1) are, it is
too easy to hit the second CA by mistake. l4alclia

May I suggest that when a command prompts with a permission
request ("really", "ok") the full word "yes" be regquired ——
or at least "y", Something other than the character

immediately preceding (CA). — David Crocker. l4alclb

TNLS Prompting Change >NLS? L4ald
Requirements: l4aldl
Insert Command ld4aldla

Break Command 14aldlb
Append Command ( perhaps) l4aldlc

And other commands I may not yet know well enough:
ldaldld
Use of "at! in the echoy; just prior to user entry of an
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address implies action "at' that address, rather than
immediately following that address. l4aldldl

Echoing "after'" instead of "at?! will make the logic of the
command coincide with the conventions of the English
Languagey thereby helping users keep track of curser and

command affects, — David Crocker ( DHC) l4aldle
Mouse Button Case Shift >KEV NLS? l4ale
Requirements: l4alel

I propose the following:
If the CD button on the mouse is depressed and a keyboard
character is struck it is the same as hitting a shift

character on the keyboard, l14alela

I also propose a new case shift —— (all three mouse buttons)

which will be a control case for either the keyboard or the
keyset. l4aleldb
State Register >NLS? 14alft
Requirements: l4al £l

I propose a state register for Display NLS (this would be
useful when learningzg NLS or when system is slow.) This state
register would indicate what NLS Is expecting (if anything)
from the usery; e.ge.y bug selection or literal typein or CA,

etc.y — KEV l4alfla
NLS Exec Commands >NLS KEV? l4alg
Requirements: l4dalgl

I propose that NLS incorporate the following exec commands:
Diry, DEL, Expunge, Copy (Disk Files only), Rename, DSKSTAT.
All of these would be fairly easy to implement and would
provide user with ability to use mouse when doing file

manipulations. l4algla
OP Char Getting >BLP WLB l4alh
Requirements: l4alhl

Change the way the Output Processor gets its characters from
NLS to a way similar to the compilers —— it's much faster.
l4alhla
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Jnum Journal Distribute >WSD? JDH? l14ali
Requirements: 14alil
For Journal distribution: l4alila

Let j—-number{s) be acceptable in the distribution
specification to indicate distribution to all who received
the original document(s) indicated by the j—number{(s).

l4alilb
File Verify Messages >DWHP NLS l4alj
Requirements: 14aljl

Have File Verlify say what kind of error it finds. l4aljla
DEX Directory Sink >HGL KEV? l4alk

Requirements: l4alkl

Get a system similar to KEVs printer spooling program which
will permit user to send requests to have files processed by

DEX in background every X minutes. l14alkla

({ Perhaps like WSDs NIC "tasks" file driver for compilations?
1 Like KEVs better for this purpose.) l4alklb
Baseline New Task Cmmnd >BLP L4all
Requirements: 14alll

A command in the Baseline subsystem by means of which people
can submit new tasks, bugs, etc. for lLater inclusion in

Baseda ta. l4allla
Entity Records PWHP l4alm
Requirements: l4alml

Entitites in NLS represented by data structure. Edit routines

interpret these in command execution. ldalmla
Edit X DWHP? 14aln
Requirements: l4alnl

Allow user to define a textual entity (by means of a CONAN
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pattern or FIND statement or something) and then be able to
perform all the normal textual editing on that entity. There
should be two user defined entities: one selected by one bug
select and another selected by two bug selections.
l4alnla
Design: l14aln2

There would be a command to compile the CONAN pattern/Find
statementy, and the code would be executed as an entity

delimiter routine. 14aln2a

DNLS Journal Command >JDH? WSD? L4alo
Requirements: l4dalol
Reinstate the Journal commands in DNLS. l4alola
Command Backup DWHP? l4alp
Requirements: l4alpl

Allow user to undo one or more commands that have been

executed. ldalpla
Costs: 14alp2

1 man-week [CHI] 14alpa
Assembler Loader NLS >JTN? ldalqg
Requirementss i4alqgl

Allow NLS files to be input to the assembler similarly to

L10. Allow access to the Loader within NLS. l4algla
Portrayal Generator >WLB CHI Lldalr
Requirements: l4alrl

Make one program that performs all the current functions of
Create Display, the Output Processory, TNLS Print command, and

Quickprint, l4alrla
Smarter Fast Create Disp >CHI1 l4als
Requirements: lidalsl
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Make the fast Create Display smarter, e.Z2.; it rather than
the full Create Display could sometimes do the display after

some structural editing. l4alsla
NLS Efficiency Measure >DIA? i4alt
Requirements: l4altl

Take measurements on NLS to determine where the bottlenecks

are, l4altla
Peter and his interpreter could help here. l4altlb
Execute Deunlock >NLS l4alu
Requirements: l4alul

A command thaty, if the file were In an unlocked state and a
partial copy existed (but probaly was deleted)sy would
undelete the partial copy, and mark the file as having a
partial copy. In other words a command to undo do the
effects of an Execute Unlock where there had been no

intervening editing of the file. l14alula
New File Command >NLS 14alv
Requirements: 14alvl

New File command: which will accept a file name, and create
an empty file under that name. ld4alvla

An approximate syntax might be (assuming Name Delimiter is
moved to another slot, e.g. Execute Name Delimiter):

l4alvlal
Nl ew file name: ] FILENAME CA [new/old] CA
l4alvliala
At the completion of the command, the user is left in his
newly created file. l4alvlia2
Ends Only Substitute >NLS l4alw
Reguirements: 14alwl

The SRI editing program SCRIBE has a command like substitute
which includes the following feature:

Deletion or replacement: Type the text to be removed. If 4t
is a long segmenty, it may be shortened by typing only the
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beginning and ending, Jjoined by "aess"s
It sure would be nice if NLS substitute had a similar feature

to save typing $CH. — DVN l4alwla
Jump Display Return >NLS l4alx
Requirements: 14alx1

We should consider a new feature that would not like Jump
File Return, but would restore previous (2-5?) Display States
when split screen was in use. Default could be JFT in

effects — JCNa. ldalxla
Default Directories >NLS l4aly
Requirements: l4alyl

A list of default directories, supplied by each user for
himself, When one types a link, or load file, if the file
specified is not in his directorys then the list of default
directories is used to look in other directories — MSC.

ldalyla
Dsply Area Jump Ret Stck >NLS l4al=z
Requirements: l4alz1l

Would it be reasonable that when you create a second display
area by Goto Display Areay, it should inherit the link stack

of the (a) previous area? — Hence you could jfr and get to a
file you often want —— DVN. ldalzla
NLS Utility Stuff >NLS ld4ala®
Requirements: L4ala*l

Make XXX or NLS a legal ID and have both runfiles and the
TASK program use it. l4ala*la

Add Outproc (print using the Output Processor) and Load as
operations for the TASK progrm. Load's operand would be the
name of a RUNFILE. The Goto Exec command would be used -—-—

BLP. l4dala¥*lb
Change TNLS Address Spec >NLS l4alaa
Reguirementss: l4alaal
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Change TNLS address specificatlion so that all selections
(after the first) are relative to the previous selection,
rather than relative to the CSP —— JGM, MFA, BLP,

14alaala
Change Echo of Subs >NLS l4alab
Requirements: 14alabl

The grammar of most NLS commands is: verb noun argument,
Substitute does not follow that grammar. It could if it went:
{on the analogy of break and append which default the noun):

l4alabla
S[ubstitute text in] Statement CA ADDR CA
Branch
Plex
Group 14alablal
The change could go in at the time of Chuck's various
proposed changes, l4alablb
EXEC Commands in NLS >NLS
*%*14alac
Requirements: l4alacl
Put (some) EXEC commmands Into NLS. l4alacla
(see — Journal, 6229) l4alaclb
Message Display >NLS l4alad
Requirements: l4aladl
When in Display NLS if an error occurs, rather than having
flash on and off (before one has a chance to read it) display
it until the first character after 5 seconds of displaying it
is hit — KEV. l4aladla
Restre Standrd Viewspecs >NLS l4dalae
Requirements: l4alael
How does a command that restores the user to default
viewspecs state grab you. (A terrific thing for people who
louse up on viewspecs unwittingly) —— MFA. l4alaela
Change Link Selection >NLS l4alaf
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Requirements: 14alafl

Change Jump to Link such that a bug selection searches from
bug to right to find link if not found continue search at

start of statement. l4alafla
Links Space Delimiters >NLS l4alag
Requirements: l4alagl

Spaces could be used as field delimiters in links. It would
facilitate the use of the typed in Jump Link command ——
particularly when the Load File command goes away. Commas
would have a higher precedence; so that all existing links

would still worke. l4alagla
Jump To Last Edit >NLS il4alah
Requirements: l14alanl

A command that jump to the statement last changed or inserted

Short Status Command >NLS

Requirements:

An Execute Status Command that
defTault link directory,

Execute Status Display >NLS

Requirements:

EXECUTE STATUS DISPLAY to show
chars/line, char size, default

Preinsert Command >NLS

Requirements:

Have a Preinsert rather than a
then make sense for structural
Overwrite Command >NLS

Requirements:
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and creation date.

l4alanla
l4alai
14alail

only told about lockedness,

See (7931, ).
14alaila
ldala,j

l4dalajl

info about a window (lines,
dir, file loadedy ..) — LPD,

l4alajla

l4alak

l4alakl

Leftinsert command. It would
entities too - LPD.
14alakla

l4alal

l4alall
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Like the Replace command except that the original copy of the

thing used to replace is deleted. 14alalla
Create Display Fonts >NLS l4alam
Requirements: idalaml

Underline, overbar, boldface, italics fonts in display nls —

requires some thought on implementation. l14alamla
Bug Literal Displays >NLS l4alan
Requirements: l4alanl

Facility for bug selecting things in the literal display area
(and other special display areas), Could be used to delete
files from directory listing, Baseline parameter

specification, etc, l4alanla
Send Bug Select >NLS l4alao
Requirements: l14alaol

Allow a user to bug select the result of a Send —— at least
for jump commands and possibly for structural editing. The
result of selecting an a—-string would be the same as

selecting the current statement when the a—-string was sent.

ldalaola

Buyer(s): l4alao2
(yBaseline'Tools) l4alao2a

Send Scroll >NLS l4alap
Requirements: l4alapl

In DNLS allow the user to see ALL the a-strings generated by

a statement, 14alapla
Yield Command >NLS l4alaq
Requirements: l4alaql

I often find myself al ternating two commands or one command
with a variety of others, It would be very handy to be able
with one or two finger movements to return to the previous

command as you can return to a previous wview or return from
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the jump family. Since "y" is free, [ suggest the name "yield

command"”, I've chatted with Chuck about this —— DVN.
l4alagla
Exportable TNLS >NLS l4alar
Requirements: l4alarl

Stripped down TNLS that can run on any TENEX. Need to find
where incompatibley, i.e., own JSYS's, and reorganize files so
that can load simple cut down TNLS with no special

subsystems. l4alarla
Q Asking NIC Locator >NLS 14alas
Requirements: l4alasl

A facility meant for a tyro NLS user that would ask him
questions in order to see on—line doumentation files as
opposed to the present method ( the NIC Resource Locator)
which requires some knowledge of NLS to use it. l4alasla
NLS Command Parser Out >NLS l4alat

Requirements: l4alatl

Move part or all of NLS's command parser/specification out of

NLS —— like to an Imlac, remote site, etc. l4alat la
Signals across Stacks >NLS l4alau
Requirements: l4alaul

Currently Signals cannot be passed from a routine using a
stack associated with a sequence to any routine on any other

stack. l4alaula
Types of NLS Users >NLS l4alav
Requirements: l4alavl

The Identification file will say that each person is a kind
of user and NLS will treat each type differently.

l4alavla
RINS NP >JBEN JCN RWW 14b
Requirements: 14b1l
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Research INtelligence System; l4bla
Subtasks: 14b2
Cat Data Element Revise >JBN JCN RWW 14b2a
Requirements: l4bZlal

Present data element set too restricted;

a more univeral one

is needed, l4b2ala
RINS Entry Conventions >JBN JCN 14b2b
Requirements: 14b2bl

Formal procedures for order,

receipt, and processing of RINS

(non=-NIC particularly) materials needs documentation.

14b2bla

TENEX NP >DCW DIA JTM WHP RWW KEV? RLD? l4c
Subtasks: l4cl
Auto job Controller >DIA DCW l4cla
Schedular Mods NP >DIA l4clb
Requirements: l4clbl

Change the schedular so that each job cannot get more than x
times 1/nth of CPU time where n is average number of jobs in

the Go state and x is small. l4clbla
Bid Scheduling >DIA DCW? KEV? RLD? WHP RWW? l4clc
Requirements: l4clel

Implement a scheduling algorithm for hardware resources that
employs bidding for those resources by the users. BBN people

may do it or help. l4clcla
Costs: l4clc2

9 man—weeks [ KEV] l4clc2a

Net Overhead Statistics >DIA JTN? l4cld
Requirements: l4cldl
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Collect statistics on the percentage of time (overhead) spent

handling Net traffic l4cldla
Stand Alone Drum Diag >DCW KEV? RLD? l4cle
Regquirements: l4clel

Need stand allone capabllty — preferably same diagnostic.

ldclela

No More Room in PSBH >DCW KEV? RLD? l4clzt
UPDL Too Small >DCW KEV? RLD? ldaclyg
Requirements: l4clgl

updl too small (consequence of no more room in PSB)

l4clgla

Limited Number of JFNs >DCW KEV? RLD? 14clh
Directory Size Too Small >DCW KEV? RLD? l4cli
Requirements: l4clil

Solution: double directory or rst's "new" file system.

l4clila

Portrayal Generator NP >WLB BLP MFA l4d
Subtasks: 14d1

OP Singer COM >BLP l4dla
Requirements: l4dlal

Add the Linc—=Singer MS-5000/6000 as another device to the

Output Processor. l4dlala
Output Device QED >¥LB BLP? 14dlb
Requirements: l4dlbl
Output Device QED doesn't work. —— Bruce l4dibla

OP Reference Guide >WLB l4dle
Regquirements: l4dlcl

Keeping the Output Processor Reference Guide up—to—date.
lddlicla
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Diddle OP >¥LB BLP L4dld
Requirements: l4dldl

Change character input from NLS statements to use byte
pointers. l4dldla

Change LSGCOL to use byte pointers to deposit characters.

l4dldlb
See Iif can rid of labels in LSGCOL. l4dldle
Make DLIBE readable, l4dldld
Combine OPEXEC and OPUTIL. l4dldle

Put all writable declarations (OPDATA, DLIBE, DVAL) together.

14dldl ¢
IF expressions 14dldlg
Igl — Ignore Line 14dldlh
LShow — Line Show 14d1ldli

SVLC —— Statement Visible Line Count (for guery only)
14didlj
Design OP User Aids >WLB MFA l4dle
Requirements: ld4dlel
Design Output Processor user alds. l4dlela
Publication System >WLB? 14d1 ¢
Requirements: 14d1£1

Automatic generation of tables of contents and various kinds

of indices. l4dlfla
OP Right Justification >WLB l4dlg
Requirements: 14dlgl

Get the Output processor to do "right justification" by means
of inserting extra spaces between visibles. l4dlgla

Hardware NP >EKV WLB? BLP? CHI? l4e
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Subtasks:
Graphic Hardcopy Study

Reqguirements:

Look at developing an
text/graphic hardcopy

Bryant Disk Mods
Requirements:
Modifications to
Priority is low.
Costs:
1 man—week (RDB)
Modify Keyboard

Requirements:

ESRI-ARC. JCN 20—-APR-72 7:45 10124

10 MAY 72 for: All

l4el
>EKV? WLB? BLP? CHI? i4ela
l4delal

in-house facility for producing

output. l4elala
2>EKV? l4elb
l4elbl
the Bryant disk controller to clean it up.

l4elbla

It hasn't caused any problems yet.
l4elblb
l4elb2
l4elb2a
>EKV l4elc
l4elcl

Move rubout key and add a line feed key on display keybhoards.

ldelcla

Change Mouse >EKV?

Requilrements:
It has been suggested to
command accept button is
buttons are to the right
slide rather that the top
Speech String >EKV?

Requirements:

l4eld
l4eldl
redesign the mouse so that the
under the index finger and the other
of the CA button and probably on the
of the mouse. l4eldla

l4ele

l4elel

Allow a representation of speech to be part of an NLS node.

Audio Feedback >EKV?

Requirements:

Think about audio feedback for NLS users.
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Documentation NP >MFA DVN HGL DIA JTM JDH DCW KEV? RLD? 14r¢
Subtasks: 1411
Diagnostic Documentation >DCW JTM JDH KEV? RLD? l4fla
Requirements: l4flal

Write documentation describing all our diagnostics and how to
use them. Also document such things as unit reference cells

and command tables. l4flala

Tree Meta Report >HGL DIA DVN 14flb
Requirements: L4flbl
Interim report plus: 14flbla

more work on the Program Environment section 14flblb

a detailed example i4fiblc

more examples in the semantic section 14filbld

a section on bootstrapping compilers l4flble
possibly a section on history i4flblr
Network User Guide >JTMN? MFA? 14flc
Requirementss 14flcl

A document that tells ARC people how to use the Network ——

Telnety; the Mailbox, file transfer, etc. — BLP. l4flcla

TENEX Pager Document >PDIA? JTM? 14f1ld
Requirements: 14f1dal

An explanation of how the pager works. l4fldla

Audio Visual Presention >DVN? L4fle
Requirements: l4flel

We may want to do a thing to replace and update the Movie
presentation of ARC. l4flela

59



ESRI—-ARC. JCN 20-APR-72 7:45 10124

Baseline Task Requirements as of 10 MAY 72 for: All
Library Catalog NP >RWW WLB l4g
Subtasks: 14g1
Catalog Quality Control DRWW l4gla
Requirements: l4glal
Catalog input quality control. l4glala
Catalog Query System >RWW WLH 14glb
Requilrements: l4glbl

The first pass at a way of on—line querying of our catalogs.

ldglbla

Long Range NIC Problems D RWW 14h
Subtasks: 14nhl
Microfilm Study D>RWW l4hla
Requirements: l4hlal

We need to study reader copiers for use experimentally in

Journal System ldhlala

Fiche Production > RWW l4nib
Requirements: 14hibl

What service firms are in the area with FRB0O, etc.

l4nibla

Fiche Reading PRWW l4dhle

Fiche Frame Jump >RWW l4nld
Phototypesetting >RWW l4hle
Collect Distribute Philo >RWW 14nlft
Requirements: L4nhlfl
Collection and distribution philosophy. l4nlfla

Card Catalog Management >JBN? WLB? ?2?7? 14i
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Requirements: 14i1l

To help manage a card file (when for instance we are printing items
out onto cards for easily updatable card catalogs). Like need to
have a record in the computer of what items are in the card "deck",
so new cards, or "card—-pullout" directives, can automatically be
printed when a change is made in the collection thus catalogued.

14ila

Card and Label Print PRWW? JBN? ?7?7 14,
Requirements: 1441

le Find card and label stock. l4jla

2. Decidey, special NL Typewriter (TTY 37 would be find), or change
for special output on our line printer. 14jlb

3. Output Processor addition so as to drive the printer to print on

successive labels or cards appropriately. l14jlc

UCSB File Transfer Experiment >JTM l4k

Reguirements: 14kl

Try a file transfer to UCSB to see how it works. l4kla

CAI DRWW? 141

Requirements: 1411
Computer Aided Instruction, Provide some tools and perhaps systems

along these lines. l4lla

External Collaborator Coord >DCE JCN 14m

Requirements: 14ml

Coordinating our collaboration with non—ARC people. l4dmla
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Fir Pod Notes, Meeting of April 18, 1972. Present: RWW, DCW, CP,
JR, JFV, MEJ o Guest: DCE.

DCE had been Invited to attend this Fir POD meeting as a guest,
The suggestion was again made that DCE become a member of a POD
and the invitation was extended to him to attend Fir POD whenever
he has the opportunity and/or to become a fulltime and
functioning member of Fir POD.

The dynamics of the group was noted to have changed a good deal
by the presence of DCE; tending to become somewhat polarized into
operating as a group vs, (or interacting with) Dougy, rather than
a group interacting within its own members, as had become true of
Fir POD during the last few meetings. This was not nearly as
pronounced as it is with PODCOM meetings (group vs, Doug), but
the effects were definitely noticeable. The opinion was
expressed that the group is strong enough to halt this
polarization within a few meetings and absorb Doug into the
groupy, to become just another member, This was already
noticeable by the end of the meeting.

The following is only intended to convey some of the points made
by DCE and Fir POD members Iin the course of the group discussion,
not as a transcript of the interaction.

(1) DCE feels (has found through past experience) that an idea
will be lLaunched and, as time passes and people have been busy
"doing their thing" on the projecty, DCE will suddenly find
that the staff members have taken the original idea and
changed it considerably and are busy building a structure into
the project that was never intended to be there. He will
discover that the project is heading (or has already arrived)
in a direction that is not compatible with the original idea.
Often, this incompatibility has been built into the very basic
idea of the project and cannot be easily corrected, Obviously
(to Doug)y there was not a meeting of the minds (there was
faulty communication) between Doug and the sttaff members in
the construction and development of this project, although at
the time DCE thought that there was complete understanding.
This has in the past caused confusion and problems in the
development of ARC toward Doug's often fuzzy ideas of ARC
goals.

(2) DCE has in the past had some experience with encounter
groups and feels his interaction with these groups has helped
him to understand himself better, to fully appreciate his
attitudes and beliefs and integrate his thinking and opinions,
and has helped him to communicate better with the world
outside himself,
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(3) DCE has over the past several years had psychology

consultants work with ARC and tried wvarious other

group—interaction methods, each of which showed some

improvement for a time, but soon the situation seemed to

deteriorate againy and lines of communication seemed to break

down. 4c

{(4) PODs are a natural evolution in the chain of attempts DCE

has made to establish better lines of communication within

ARC. (DCE split ARC into a balanced mixture in each POD,

choosing the mebership of each POD very carefully — see

PODLAUNCH paper; .Jdal through .Jalb —— with a balance of

membership in mind,) 4d

(5) DCE has been very surprised and rather disappointed in

the negative reaction of ARC staff members to POD activity.

He fully expected each of the PODs to set up, and carry

throughy group interaction activities, exploring with as much

depth as they felt comfortable into what the shortcomings and
weaknesses of the individual are as a member of the working

team. RWW pointed out that there has been a lot of

experimentation in small groups that we could bring in and

that we should be aware of. 4e

(6) DCE felt that PODs were not created solely for en_joyment
of "bull sessions", but were created to help alleviate the
problems in interaction with each other and with DCE. 4f

(7) JFV stated that POD activity lacked criteria toward

Judging its effectiveness; that it iIs somewhat like a program

with no input and no output. Also there is a lack of

opportunity to learn by making mistakes. PODs are not meant

to make suggestions; therefore cannot learn by doing. 4g

(8) DCW asked why DCE did not want to be a member of a POD and

DCE stated that he was afraid that his presence might

overbalance the direction the POD was going. RWW felt that

DCE'"s presence as a member of a POD would make PODAC healthier

and be good for DCE. 4h

(9) The opinion was given that DCE should let go of PODCOM

and not exert so much control over its activities and should

allow it to take more initiative, DCE stated that he wanted

PODCOM to take initiative but reserved the perogative for

veto. We pointed out to DCE that newcomers feel that they are

being told to not take initiative. It was stated to DCE that

he does seem inconsistent in telling people to take initiative

and then refuse the action takeny, or if not refusing, to seem
worried, 4i
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(10) It was pointed out that if PODs are supposed to be of
value to the world, we should expect both positive and
negative statements about what we are doing to be reported to
the world as they naturally occur during the activity.

(11) DCE stated that each POD should feel free to call on
outside help from consultants, talks, lectures; that the POD
members can do reading and searching for group interaction
information on their own time outside office work; attend
whatever lectures and/or classes or other means they might
find to assist them in learning about encounter groups, T
groups, and group dynamics, for the purpose of enhancing the
POD work. He stated that SRI would foot the salary bill up to
20% but he hoped to keep it no higher than 10% of total salary
time,

(12) DCE feels that the group should be able to accomplish
useful POD activity on their owny during the two hours per
week assigned to POD activities, with occasional (agreed on
with DCE in advance) consultants and/or lecturers, as the need
is felt, It was pointed out that there are no professional
psychologists, sociologists, or psychiatrists on the ARC
staffy, and that, while many of the ARC staff have had
encounter group experience, none could possibly make the claim
to be of professional quality, and none apparently wish to be
responsible for the dynamics of such a group activity. DCW
pointed out that individual reaction to such group working can
be negative as well as positive, that there are dangers
inherent in the use of group dynamics. DCE still felt that
the group could handle the job themselves.

(13) Areas of personal and organizational development that
DCE feels need looking at for eacc of us is to understand our
attitudes and beliefs about our working environment,; things we
are doingy things that are wrong ( this sentence dictated by
RWW ). It was pointed out to DCE that each of us has our own
personal development plans.

(14) DCE also reiterated that he had no intention of stopping
POD activity and that attendance was, as from the beginning of
POD activity, a part of the ARC job function. He said that he
expected POD activity would evolve and change as we learned
more. He said that he really didn't know how PODs were going
to develop; that teams of the future would involve some
POD-llke activities. He believes that complex situations of
the future must be handled by teams, since they are too
complicated to be handled by one individual.

(15) DCE pointed out that it would be helpful to run POD

4j

4k
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activities with prepared programs and presentation by the
memhers.,

10125
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Gus is a consultant in "organizational development"., Oak Pod has
arranged the visit.
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Oak Pod has arranged to have Gus Matzorkis visit ARC this Friday,
4/21.

We have arranged this wvisit to find out what goes on outside ARC
under the name of "Organizational Development",

Gus has been working in organizational development for more than
five years, independently as a consultant for the last two years.
His last regular employment was with Sheldon Davis at TRW (see
Innovation #25) and he continues to work with Davis. Recent
frequent employers include the UCLA Institute of Public Affairs
where he works in Police—~Community Relations; and the Postal
Service Management Institute where he works in a wide range of
organizational development efforts.

He is active as a writer of social criticism (e.ge. New Republic)
and jazz criticism (e.g. Downbeat).

All ARC is invited to meet with Gus in the conference room from
10230 "til noon. He will be available the rest of the day to
meet with individuals or small groups.
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